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Sabrina Stevens, project manager for the Internet development project, comes running into the office of 
Jack Jones, the project sponsor.  “Jack!! Your not thinking of changing the requirements on the e-
commerce web site are you—I heard a rumor!!  You know we talked about this at the beginning of the 
project when we wrote up the requirements.  We told you we would freeze the requirements after the 
conceptualization and definition stage because to change the requirements means that we have to go 
back and change everything—the requirements document, the project budget and plan, and because 
we’ve started execution, the functional specification, the design document, even some of the web 
modules.  Sooooo, I’m hoping this rumor is wrong, Jack, because if it isn’t you’d better be ready to shell 
out the big bucks.” 
 
“Sabrina, when we wrote those requirements, eleven months ago, our structural dynamics practice 
wasn’t growing like it is now.  You know it has been growing at the rate of 15% a month!  For us not to 
have an e-commerce connection for that part of our business is to totally misrepresent what our firm is 
evolving into.  I know it’s going to be expensive to fix; I know you basically have to re-write all the 
documents beginning with the requirements document.  At this point, we have two choices—either we 
effect this change now, or I cancel the project and hire an outside IT firm to re-build our web site!” 
 
“Jack, you’ve got to be kidding!! You know we promised corporate we’d have this site up by the middle 
of the year.  You know we’re already behind schedule without this change.  And, have you looked at 
the budget lately?  We have just barely enough to finish out at this point and that’s assuming everything 
goes well here as we approach testing and going live with the new site.  Wouldn’t it be better to deliver 
on what we originally conceived and defined and then effect the changes you’re proposing in a second 
follow-on project??  Like I say, hope you’ve got lots of money.” 
 
“Sabrina, as I said, you agree to do this now or I’m canceling your project and going outside with the 
whole thing—the choice is yours!!” 
 

 
 
Finally, we have arrived at the point where execution of the project can begin.  In actuality, the lifecycle 
we have been describing is a kind of meta or super project methodology.  One purpose of this lifecycle 
is to get to this point with a well-defined concept or product for the project and a well-developed plan 
and budget for execution of the project.  With the deliverables of stages one and two in hand, stage 
three of the lifecycle can begin.  And in doing so the steps determined in stage two are started and 
executed in sequence. 
 

Critical to the success of this stage will be performance assessment.  Performance 
assessment provides a measure of the progress and success of a project.  Performance reporting is 
also the history of the project and, as a famous cliché states, those who do not study and record history 
are doomed to repeat it.  This is definitely true in projects.  If you do not measure and report the 
performance of a project, you will not only lack the knowledge of the current status of your project, but 
you will also be unable to learn from your past mistakes or successes. 
 

Chapter 12 
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Processes Involved 

 
The following processes are entailed in this the third stage of the meta-project—Execution and Control. 
 

KNOWLEDGE AREA – subordinate process 
 
SCOPE MANAGEMENT – Scope change control 
TIME MANAGEMENT – Schedule control 
COST MANAGEMENT – Cost control 
QUALITY MANAGEMENT – Quality control 
HUMAN RESOURCE MANAGEMENT – Team development 
COMMUNICATION MANAGEMENT – Performance reporting 
RISK MANAGEMENT – Risk response control 
PROCUREMENT MANAGEMENT – Contract administration 
 
Each of the above processes possesses, inputs, outputs and tools and technologies as depicted in 
Figure 12.1 below for integrated change control. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 12.1:  Inputs, Outputs, Tools & Techniques for the Change Control Process (PMBOK, 2000) 
 

To Freeze or not to Freeze, that is the Question 

 
The point of the opening scenario was to bring home, once again, the effects of changing requirements 
in this, the execution and control stage.  Ideally, most project managers1 would prefer frozen 
requirements.  Previous to execution of this stage, the project stakeholders along with the project 

                                                      
1 If the project manager is external to the firm, he or she may actually solicit changes, knowing full well that the 

customer must pay extra for them.  Typically, the external contractor has a fixed price contract to deliver a specific 

product.  Further, the external contractor usually wins this contract by being the lowest bidder.  The contractor 

doesn’t expect to make any money on the actual contract but on the changes requested by the customer.  So, 

when customers request changes, they can expect to pay dearly for them.  In this kind of environment, THE 

CUSTOMER IS ALWAYS RIGHT!!  But the project is never completed on time or within budget.  From the 

contractor’s point of view, that wasn’t the money-making plan anyway. 
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manager have determined if the project is to have frozen requirements or if the project will permit some 
kind of change control system or process to assess what changes will be allowed.  All such 
deliberations must be contemplated in the context of a variety of considerations:  1) the contractual 
arrangements, 2) the need to get some functionality out as soon as possible, 3) the need to create a 
product with competitive or superior functionality vis-à-vis competitive products, and 4) the fact that 
everybody wants changes toward the end of the project. 
 

It has been said that frozen requirements are akin to the proverbial abominable 
snowman—both are myths and both are melt when enough heat is applied to them.  The more 
modern approach to changing requirements (which constitute changes in scope) is to utilize a 
change control system.  The policies governing such a system are the following:  late breaking 
changes in the scope are always costly and nearly always result in cost and schedule overruns.  
In many cases it is better to hold off on the change and wait for a follow-on project to deliver the 
next version of the product.  There are exceptions—when the product being produced is a 
commercial one and new commercial products have appeared in the market space with much 
more functionality.  In such cases, without competitive functionality, the project might as well be 
terminated as the product will be inferior and may not sell.  Another case might be when the 
organization’s requirements change due to external influences coming from the competition, the 
customer, or changing technology.  Wallace (2002) stated “Scope change is a good thing, not a 
bad thing. It is wrong to resist all scope change. Where a scope change generates improved 
benefit, it should be proposed to the project's decision making body.”  Thus, by controlling scope 
change effectively, a project manager will be able to maximize the value of a project. 
 

The use of a change control system belongs to a relatively new discipline known as change 
management.  A simple “best practice” within this system is to use a change control board to litigate all 
proposed changes, which are written up on a standard-template proposed-change form. 
 

Forces Pushing for Late-Project Requirements Change 

 
There are many scenarios that lead to late-breaking changes in the requirements for a software 
system.  Here are just a few examples.  The competition introduces a new version of a competitive 
product with unanticipated KILLER features.  The development team has no choice but to endeavor to 
replicate these features even though they were not in the original requirements specification.  Another 
“event” that tends to unfreeze requirements is new work that is undiscovered late in the project.  Again, 
this work must be done, even though it was not in the original requirements.  Yet another reason for 
why changes are made to the requirements is that a “Wouldn’t It be Great if…” scenario happens.  
End-users want changes because they now know more about their requirements than they did 18 
months ago.  Developers want changes because they have a great emotional and intellectual 
investment in all of the system’s details.  Frequently, the technology changes so rapidly that the current 
system being developed is obsolete even before it gets finished, which means that its requirements 
must be changed or that the project must be killed or that the deliverable must be completed even 
though it will be technologically inferior. 
 

The successful project manager has learned that rigorous scope control is essential to deliver 
projects on time and on budget. The prime focus for the project manager should not be to deliver the 
agreed scope on time and on budget, but to optimize the benefit generated by the project. If that means 
allowing the scope to change then this scope change is a good thing, not a bad thing. It is wrong to 
resist all scope change. When a scope change generates improved benefit, it should be proposed to 
the project's decision-making body. Make clear the positive and negative impacts of allowing the 
change. Make sure the impact is fully reflected in the project's definition and performance criteria. All 
participants should understand that the later in the project that a change is addressed, the greater the 
affect in terms of costs, risks, and timescale. It is wise to surface potential changes as early as possible. 
The change control process should make it easy to do so. 
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Project Execution 

 
Execution is the missing link between aspirations and results.  In the past firms got away with poor 
execution by pleading for patience.  Today, a company can win or lose serious market share before it 
even realizes what has hit it.  Today, a firm that is publicly held can see its stock price cut in half 
because of poor execution.  As in sports, execution in business makes the difference between winning 
or losing. 
 

Execution is a discipline (Bossidy & Charan, 2002).  Additionally, Bossidy and Charan assert 
that execution is a major job of the business leader (viz. project leader, project manager).  And 
execution must be a core element of a company’s culture.  Leadership figures significantly in 
successful execution.  Leadership involves setting clear goals and priorities, articulating ground truth 
reality and using the creative tension between these as motivation to improve performance.  
Leadership also involved knowing your people and your business and follow-through.  Leadership, 
according to Bossidy and Charan (2002), also involves rewarding the doers, expanding people’s 
capabilities through coaching, and knowing yourself. 
 

The big story in execution is focus.  It is focus that gets work done on-time and with the 
required functionality and quality.  Distractions from focus are the enemies of success in project 
management.  In that regard, multitasking as defined and discussed in Chapter 8 is considered an 
enemy of good execution because it destroys focus, delays the completion of projects and often results 
in increased costs.  Student syndrome2 also is an enemy of focus because it reminds us of the college 
roommate who waited until the night before to begin work on his term paper. 
 

Project Scope Change Control 

 
Scope change control is change management by any other name and often involves configuration 
management as well.  Changes made to the requirements or to the processes planned to create the 
required product will usually involve additional costs and delays in the completion of the product, so 
acceptance of these changes should be a decision taken with great care as to consequences.  In most 
cases, it may be better to finish the required existing project and undertake the proposed changes in a 
follow-on project. 
 

An efficient scope change control process should be defined. There needs to be a balance 
between flexibility and control. If the process is too onerous, either valuable changes will be lost or the 
participants will ignore the rules - leading to uncontrolled scope and configuration. If the process is too 
easy, then many changes may be applied with insufficient thought given to their merits and 
consequences. 
 

The following flow chart describes a typical change control process. 
 
 

 

                                                      
2 By any other name, “procrastination.”   
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Figure 12.2:  A Change Control Process 
 
To start with, a potential change in the project scope is identified. This potential change is reviewed. If it 
is not considered beneficial to the success of the project but will impact the project result if left 
unattended, an issue is recorded in the Issues Register. If it is considered, the change is then 
evaluated. If there is no impact on the project deliverables, budget, or schedule, the change is made 
and documented. Otherwise, the calculations are made and the Change Order Form is completed. The 
customer and/or the Change Control Board review the Change Order Form. If the change is approved, 
it is implemented and then documented. If the change is not approved, something remains unresolved, 
so an Issue is raised and resolved through that process. 
 

The change control process will involve a combination of procedures, responsibilities, and 
systems. The key to success is to have a well-controlled but efficient process defined in possibly the 
project charter. Stakeholders must define and agree on the membership of the change control 
board(s), the detailed procedures, forms, etc, protocols for levels of authority, e.g., what types of 
change can be approved without reference to the project's business owners, linkage to other 
management procedures, e.g., the issue management process, configuration management, which 
tools will be used to support and manage the process, how to communicate and promote the process 
and its importance to all participants. 
 

Figure 12.3 exhibits the scope change control process in terms of inputs, outputs, tools and 
techniques as adapted from PMBOK. 
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Figure 12.3:  Inputs, Outputs, Tools & Techniques for the Scope Change Control Process (PMBOK, 
200x) 
 

Project Schedule Control 

 
Unlike construction and aerospace projects, knowledge and IT projects have a visibility problem.  With 
construction projects, it is apparent by merely looking at the structure to see the progress.  With 
knowledge and IT projects, the progress is a lot less apparent because it is hidden within the memory 
of the desktop computer.  One purpose for regularly scheduled meeting is to have each project player 
demonstrate his or her progress on the task assigned.  At the end of the chapter a “best practice” 
created by Microsoft years ago is that of the Daily Build and Smoke Test.  With this exercise the 
software product being developed is compiled, linked, executed and high-level tested.  As a result, 
increases in visibility become more readily apparent. 
 

In his book Critical Chain (1997), Goldratt makes a number of excellent suggestions regarding 
execution of projects.  In Chapter 8, we discussed the issues of safety, multitasking and student 
syndrome from a planning and estimation perspective.  Here, we want to revisit those and other issues 
from an execution perspective. 
 

Execution of projects has been likened to that of a car race.  It ought to be according to plan 
and it ought to be with expediency and focus.  In his novel, Critical Chain, Goldratt makes a substantial 
case for focus.  Project managers should stay focused on the critical path.  Initiatives should be taken 
so that only one path is critical and no other path can become critical.  Project players should stay 
focused on their assigned work that they have currently under way.  In his 1997 novel, Goldratt 
suggests that when a team member’s critical task3 is coming into view, he or she should be advised a 
week ahead of time that the contribution he or she will make is coming soon.  When that team member 
receives his or her “deliverable” and begins to add value to it, he or she is expected to drop everything 
and do nothing but work on just that task until it is complete, then pass it on immediately to the next 
resource person on the critical path, even if it is completed early.  There should not be any multitasking4 
in conjunction with critical tasks, nor should there be any student syndrome5. 
 

                                                      
3 A critical task is a task that is on the critical path. 
4 Multitasking is doing several tasks concurrently. 
5 Student syndrome is Goldratt’s term for procrastination. 
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Multitasking, Student Syndrome, Safety 

 
As described above, multitasking and student syndrome are the enemies of focus and therefore can 
cause serious delays in the completion of projects.  Multitasking, as everyone knows is doing several 
things at once, whereas student syndrome is postponing until near the due date work that should have 
been accomplished sooner.  Safety is the excess time over and above the time required to complete a 
task by a certain due date with .5 probability.  These are all concepts that were extensively discussed in 
Chapter 8. 
 

Project Cost Control 

 
Project cost control includes monitoring cost performance, ensuring that only appropriate project 
changes are included in a revised cost baseline, informing project stakeholders of authorized changes 
to the project that will affect costs, and using earned value analysis as a tool for cost control.  The cost 
management overview diagram suggested by PMBOK is exhibited in Figure 12.4. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 12.4:  Inputs, Outputs, Tools & Techniques for the Cost Control Process (PMBOK, 2000) 
 

Project cost control is an important issue that is not always handled well in project 
management.  Cost control today is more important than ever due to the ever-increasing complexity 
and size of modern projects, and the risks involved.  The problem of controlling costs in project 
management has been recurring throughout history.  As the book Project Cost Control in Action 
mentions, the Bible takes us back 2000 years in history mentioning the function of project cost control 
quite explicitly (3).  We read: “But don’t begin until you count the cost.  For who would begin 
construction of a building without first getting estimates and then checking to see if he has enough 
money to pay the bills?  Otherwise he might complete only the foundation before running out of funds.  
And then how everyone would laugh!”  (Luke 14:28, 29, The Holy Bible, The Living Bible Translation)  
This verse not only implies cost control, but also budgeting and resource planning.  The keys to 
understanding project cost control are the general basics of cost control, who controls cost, establishing 
targets, and warning signs.  Also, understanding what the main roles of the cost engineer and project 
manager are will enable a more thorough understanding of cost control. 
 
 

Basics and General Explanation of Cost Control 
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Many things can change during a project to alter the expected rate and amount of spending.  According 
to Dennis Lock, author of Project Management, the change is usually an increase (Lock, 1996, p. 459).  
He says that the change may be unexpected, but the fault will probably lie somewhere within the 
organization.  “The principal purpose of cost control is to ensure that no preventable wastage of money 
or unauthorized increase in costs is allowed to happen,” says Lock (p. 459).  The mistake of confusing 
cost reporting with cost control tends to be quite common.  Accurate and timely cost reporting is 
essential but, alone, is not cost control because by the time overspending is reported, the damage is 
already done (p. 459). 
 
 There are two vital factors that must never be forgotten when discussing cost control: 1) simple 
controls applied early and 2) sophisticated controls applied late (Kharbanda Stallworthy and Williams, 
1981, p. 18).  An aspect of sophisticated controls is that they are always applied late, because they are 
too complex to set up early.  Project Cost Control in Action (Kharbanda Stallworthy and Williams, 1981, 
p. 18) states that it is much better to act early on fairly incomplete and inaccurate information than to act 
late on more precise information. 
 
 The three dimensions of cost control are cost, time, and quality.   These factors are interrelated 
and interdependent.  They can all be described in monetary terms.  Shorter completion times and 
improvements in quality will lead to higher cost (Kharbanda Stallworthy and Williams, 1981, p. 18).  
More recent studies tend to suggest just the opposite—faster completion times lead to lower cost and 
sometimes better quality as well (McConnell, Steve, 1996, p. 126). 
 
 According to Project Cost Control in Action, certain basic principles are self-evident, but must 
be studied and accompanied by the realization that the ability to have any influence at all on cost 
diminishes rapidly as the project progresses (Kharbanda Stallworthy and Williams, 1981, p. 44).  Those 
principles are: 
 
1) real cost control will only be achieved by sound management of the project; 
2) the accountant, and others directly concerned with costs, cannot control them;  however, their 
reports will assist the project team to do so; 
3) constant and continuous effort to control cost is required, throughout the life of the project; 
4) all members of the project team must be cost conscious; 
5) initial cost targets set should be seen as a challenge to be beaten; 
6) control is far too late, if it is initiated once excessive costs start coming in (Kharbanda Stallworthy 
and Williams, 1981, p. 44). 
 

A small project can be run extremely efficiently without recourse to detailed documentation and 
sophisticated control techniques.  However, the basic features of project cost control must always be 
constantly in mind (Kharbanda Stallworthy and Williams, 1981, p. 47).  Those basic features are: 
 
1) start control early, before design begins; 
2) plan meticulously, before construction starts; 
3) watch out for the early warning signals. 
 

Who Controls Cost? 

 
Although some may try to ignore it, cost is inevitably everybody’s business (Kharbanda Stallworthy and 
Williams, 1981, p. 20).  It is easy to conclude that costs are higher or lower depending upon workers’ 
diligence and skills applied to the project.  Management must have convictions: they must have faith in 
project cost control and trust it (Kharbanda Stallworthy and Williams, 1981, p. 20).  This is because only 
after a manager has made a complete commitment to the principles of cost control can a project 
manager and his/her team be expected to apply and implement correct cost control procedures 
(Kharbanda Stallworthy and Williams, 1981, p. 20). 
 
 The project manager’s role is very important in the cost control process, because he/she is a 
focal point for many reports, decisions, and data (Kharbanda Stallworthy and Williams, 1981, p. 20).  
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He/She will have the best “feel” for the project, and therefore will know which direction to guide the 
project.  The project manager will also have the major job of guaranteeing speedy and constant 
communication between the members of his/her team, and between owner and contractor. 
 

Warning Signs 

 
The most meaningful of all the information that can become available in relation to cost is the trend--
where are we going (Kharbanda Stallworthy and Williams, 1981, p. 135).  The book goes on to explain 
that management would always rather know ahead of time if the project budget will be exceeded.  The 
data that contributes to the early assessment of the cost trend is very valuable as it can provide an 
“early warning system” to management in relation to the estimates of both time and cost. 
 
 The first major purchasing exercise of a project is the writing of the requisitions and the placing 
on order of all the major plant and equipment (Kharbanda Stallworthy and Williams, p. 137).  This 
process occurs quite rapidly, and all the equipment is placed on order by 30% completion of the total 
project life (Kharbanda Stallworthy and Williams, 1981, p. 137).  This enables us to ascertain the 
validity of our total cost target at the 30% completion point. 
 
 The progress of value of work done is also a potential early warning signal.  This is because it 
gives a very clear picture of the potential situation to the project manager.  The project manager will be 
able to make use of this early warning signal in his/her report to management. 
 
 Dynamic data, as used by the project manager, will provide more “yardsticks” that will assist 
the project manager to “see into the future” with a certain degree of confidence.  In the context of 
project management the most meaningful of all the information that can become available is the trend–
where are we going. 
 

Major Cost Initiatives of the Project Manager 

 
The major cost initiatives of the project manager are to establish cost targets, maintain a control 
estimate throughout the life of the project, monitor performance relative to the targets, and to predict the 
final cost of all materials and services provided (Kharbanda Stallworthy and Williams, 1981, p. 181). 
 
 If the estimate that was prepared by the project manager is adequately detailed, it would be 
taken as the project control estimate.  Then the control estimate is issued to all key personnel working 
on the project, so that all knowledge on potential cost is available before those who are starting work on 
the project (Kharbanda Stallworthy and Williams, 1981, p. 181).  The estimate serves to control all 
subsequent purchasing and construction activities.  As revised estimates are prepared when more 
information becomes available, they become the target for the cost control engineer when making 
forecasts and assessing trends. 
 
 Estimate updating is the next major task of the cost control engineer.  The costs in the control 
estimate, amended where needed, and detailed per cost code, are reported in the project cost report as 
the “estimated final cost.” 
 

Earned Value Analysis 

 
Earned Value Analysis (EVA) is a “way to measure a project’s progress, forecast its completion date 
and final cost, and provide schedule and budget variances along the way.”  Earned Value Analysis is 
required in cost and schedule control because cost variance is unknown until schedule variance is 
known.  For example, if you compare actual expenditures to date with budgeted expenditures to date, 
you may observe that you have spent less than was budgeted to be spent by a certain date.  Can you 
conclude that the project is under budget?  Not necessarily.  What if the project is behind schedule?  
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Earned Value Analysis was invented by the federal government in the 1970’s to get a handle on all of 
this.  It was originally called Schedule and Cost Control System or SCCS. 
 

Figure 12.5 is an example of a graph demonstrating the difference between the actual 
cost and the budgeted cost of a project.  It shows how the actual cost of the project to date is less 
than the predicted budget of the project to date. 
 

 
 

 
Figure 12.5:  Plots of Actual Cost and Budgeted Cost over Time 
 

In order for EVA to be effective, the detailed tasks and requirements of the project must be 
completely planned prior to the start of the project.  An effective set of technical criteria to measure the 
performance of the project must also be established before the start of the project.  An effective EVA 
must also have a predetermined completion date and final cost of the project, and must maintain 
control of the performance measurement baseline.  Some additional objectives for EVA to be effective 
are to analyze the schedule status and projections and the expenditure of funds according to the work 
accomplished, not the work scheduled.  EVA must also be able to isolate problems and take corrective 
action in order to fix the problems of the project.  Every EVA must meet certain criteria in order to be 
effective and reliable.  Organizational planning and budgeting, accounting considerations, analysis and 
management reports and revisions and data maintenance are the outlines of the criteria that an 
effective EVA should contain. 
 

Earned Value Analysis requires three quantities to be computed for each activity or summary 
activity within a project’s Work Breakdown Structure. They are Budgeted Cost of Work Scheduled 
(BCWS) or planned value (PV), Budgeted Cost of Work Performed (BCWP) or earned value (EV), 
and Actual Cost of Work Performed (ACWP) or actual cost (AC) of accomplished work.  The units 
used in conjunction with each of these measures is “dollars” and each measure tends to be date 
sensitive.  Change the “current” date and you get a different value for each, generally.  Hence, each is 
a function of time.  Let’s look at each of these three terms more closely. 
 
 Budgeted Cost of Work Scheduled (BCWS) or Planned Value (PV):  For the entire project, 
this is the sum of the budgets of each work package that comprise the complete project up to a certain 
date, expressed in dollars.  Let’s consider, for simplicity just a single task.  If that single task has 
$10,000 budgeted for it and it is ten days in duration, and is scheduled to begin at some date in the 
future, then its BCWS is zero.  If that same task should already have been completed by now (that is, 
its completion date is in the past), then its BCWS is $10,000.  If the task started on time three days ago, 
then it should be 30% complete and its BCWS is $3,000. 
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 Obvious analogous statements can be made for an entire project consisting of a collection of 
tasks.  Suppose that a project has three tasks that are supposed to be complete at this point in time, for 
which $10,000 was budgeted for each.  Then the BCWS for the entire project is $30,000.  Note that the 
BCWS has nothing to do with whether the tasks are actually complete or not.  The BCWS only tells us 
what should have been spent up to a particular date. Note that the BCWS is date sensitive.  Choose a 
different date and you get a different BCWS, generally.  As mentioned earlier, we also refer to BCWS 
as the “planned value” or PV. 
 
 Budgeted Cost of Work Performed (BCWP) or Earned Value (EV):  For the entire project, 
this is the sum of budgets for completed work packages and completed portions of open work 
packages that have been partially worked on.  Or to be more precise, BCWP is the percentage of work 
actually completed multiplied by the planned cost of that work package. 
 
 If $10,000 has been budgeted for a work package and it is estimated to be 30% complete by 
its assigned resource, then the BCWP for the work package is $3,000. 
 

Actual Cost of Work Performed (ACWP) or Actual Cost (CV):  For the entire project, this is 
the sum of actual costs for completed work packages and completed portions of work packages during 
a given time period. The actual cost is not bound, but is compared to the timescale and budget of the 
Work Breakdown Structure. 
 

There are other formulas that contribute to the Earned Value Analysis. More terms are 
necessary to record cost and schedule performance and program budget. They include the following. 
 

Cost Variance (CV):  This is the difference between the Budgeted Cost of Work Performed 
and the Actual Cost of Work Performed (the difference between earned value and actual cost). Units 
employed are “dollars.”  CV is a measure of the difference between the estimated cost of an activity 
and the actual cost of that activity.  For the project in total, CV would describe whether the project is out 
of spec and by how much. A negative cost variance indicates a task, activity or project that is over 
budget, that cost more than planned.  A positive CV indicates just the opposite, that the cost was under 
budget or less than planned.  The actual formula for CV follows:  CV = BCWP – ACWP = EV – AC. 
 

Cost Variance Percent (CV%):  This is similar to the previous definition, but is expressed as a 
percentage between what has actually been earned to date and what should have been earned (CV% 
= BCWP*100/ACWP = EV*100/AC). 
 

Schedule Variance (SV):  This is the difference between the Budgeted Cost of Work 
Performed and the Budgeted Cost of Work Scheduled (the difference between earned value and 
planned value). This difference, if indicated by a negative number, shows a project that is over budget 
or behind schedule, or possibly both. (SV = BCWP – BCWS = EV – PV). 
 

Schedule Variance Percent (SV%):  This is similar to the Schedule Variance but, is 
expressed as a percentage, between what has actually been earned by what should have been 
earned. (SV% = BCWP*100/BCWS = EV*100/PV). 
 

Using the above measurements and the base measurements we can also calculate 
completion figures as follows: 
 

Cost Performance Index (CPI):  This is the ratio of work performed to actual costs. CPI can 
also be used to calculate how much it will cost to complete the project.  A CPI of one shows a project 
that costs exactly as much as predicted.  If the number calculated is negative or less than 100% the 
project is over budget.  Similarly, if the number is greater than 1 or 100% then the project has cost less 
than projected.  (CPI = BCWP/ACWP = EV/AC) 
 

Schedule Performance Index (SPI):  This is the ratio of work performed to work scheduled. 
SPI can also be used to calculate how much time it will take to finish a project.  A SPI of one indicates a 
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project that took exactly as much time as it was planned to take.  A SPI less than one or less than 
100% shows a project that is behind schedule. Likewise, if the SPI is greater than 1 or 100% then the 
project is ahead of schedule.  (SPI = BCWP/BCWS = EV/PV) 
 

Using the above measurements and the base measurements, we can also calculate 
completion figures as follows: 
 

Budget at Completion (BAC):  This is the final value of the BCWS, that is, the figure we 
expect the project to cost if it runs exactly as the Work Breakdown Structure (or other budgeting tool 
used) would predict. 
 

Time at Completion (TAC):  This is the duration of the project, as determined by the Gantt 
chart. 
 

Estimated Cost at Completion (EAC):  This figure shows the cost of the project where the 
remainder of the project is to be completed according to plan. Precisely, EAC = BAC/CPI = 
BAC*ACWP/BCWP = BAC*AC/EV. 
 

Estimated Time at Completion (ETAC):  This is the estimated completion time based on the 
current schedule performance index and the TAC.  Precisely, ETAC = TAC/SPI = TAC*BCWS/BCWP 
= TAC*PV/EV. 
 

Calculated Cost at Completion (CAC): This is the cost of the project if the remainder of the 
project is completed in the same manner as the previous, completed portion of the project. (CAC = 
BAC/CV%) 
 
 Senior Managers who manage multiple projects may find it helpful to see this information in a 
graphical format. For instance the use of earned value data placed in tables will clearly show how far 
along each project is and how quickly they arrived at any given point at a glance. In addition, 
performance charts such as Gantt Charts, histograms, and S-curves, based on the above data provide 
the various stakeholders with the kind of information and detail that is required by each respective party 
as illustrated in Figure 12.6. 

 

 
Figure 12.6:  Illustrative Tabular Performance Report 
 

Risk Control and Earned Value 

 
Barry Boehm defines the practice of Risk Management in terms of two primary activities, each 
with three subsidiary steps.  The first activity, risk assessment, consists of risk identification, risk 
analysis, and risk prioritization.  The second activity, risk control, includes risk-management 
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planning, risk resolution, and risk monitoring (Boehm, 1991).  It is in primarily two of these 
activities, risk identification and risk monitoring, that Earned Value analysis can play an important 
role. 
 

The use of Earned Value Analysis for risk identification, involves comparing actual task 
cost and schedule performance against estimated values using the methods described above.  
Specifically, the use of cost and schedule variance to assess work package performance against 
the plan will alert the manager of a project to a potential risk area whenever that task or task area 
cost or schedule variance exceeds a predetermined value.  However, this method may not 
provide absolute confirmation that the work package is in trouble.  The cost or schedule variance 
could be due to a delay in reporting or some other cause.  An assessment of earned value does 
provide an indicator of cost and/or schedule problems that can indicate an area of program risk. 
 

According to Boehm, "Risk monitoring involves tracking the project's progress toward 
resolving its risk items and taking corrective action where appropriate" (Boehm, 1991).  Earned 
Value Management is useful in monitoring the impact risk-management planning and risk-
resolution activities have on task performance, utilizing the same methods Boehm utilized to alert 
him to the risk items initially.  In addition, if the risk resolution involves rework or additional 
program tasks, these tasks should be subjected to Earned Value Analysis as well in order to 
determine their performance against the modified plan. 
 

Examples 

 
As “warm-ups” to the issues to be addressed, we shall investigate some contrived examples to gain 
intuition.  In this first example, consider the following four-task problem. 
 

 
 
Figure 12.7:  A Four-Step, Activity-on-Node Network (activity durations are numbers following forward 
slashes) 
 

In the above, assume tasks A, B and C all started on the same day, seven business days ago.  
Planned durations are in days and are the numbers in the boxes shown above.  A is 60% complete, B 
is 50% complete and C is 70% complete.  Task D has not yet started and won’t until the tasks A, B and 
C are complete.  So far, $30,000 has been spent on A, $30,000 on B, $40,000 on C, and nothing on D.  
The budgeted daily costs for A, B, C and D are $4,000, $5,000, $6,000 and $7,000, respectively.  The 
budget for A is 6*$4,000 or $24,000, for example.  Assume five-day work weeks, with no work being 
done on Saturday or Sunday.  For A, B, C and D, the BCWP, BCWS, ACWP, CV and SV are 
determined below, where the inputs are shown in bold. 
 
 
 
 

A/6

B/8

C/13

D/8

A/6

B/8
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Task Days Cost/Day Budget 
% 

COMP 
ACWP 
(AC) 

BCWS 
(PV) 

BCWP 
(EV) CV SV 

A 6 $4,000 $24,000 60% $30,000 $24,000 $14,400 -$15,600 -$9,600 

B 8 $5,000 $40,000 50% $30,000 $35,000 $20,000 -$10,000 -$15,000 

C 13 $6,000 $78,000 70% $40,000 $42,000 $54,600 $14,600 $12,600 

D 8 $7,000 $56,000 0% $0 $0 $0 $0 $0 

Totals   $198,000  $100,000 $101,000 $89,000 -$11,000 -$12,000 

 
Table 12.1:  Basic EVA Calculations for the Network Exhibited in Figure 12.7 (inputs are shown in bold) 
 

Task CPI SPI Days Ahead Days Slack 

A 0.48 0.60 (2.4) 7 

B 0.67 0.57 (3.0) 5 

C 1.36 1.30 2.1 0 

D N/A N/A 0 0 

Totals 0.89 0.88   

 
Table 12.2:  Further EVA Calculations for the Network Exhibited in Figure 12.7 
 

From Table 12.2 above, we can calculate the EAC (Estimate at Completion) using the 
constant cost efficiency rate formula:  EAC = BAC/CPI.  It should be evident that EAC = $198,000/0.89 
= $222,472. 
 

Likewise from Table 12.2 above, we can calculate the ETAC (Estimated Time at Completion) 
based on the TAC (Time at Completion).  Since ETAC = TAC/SPI, it should be evident that ETAC = 
21/0.88 = 23.86.  Days Slack (in Table 12.2 above) is determined by standard conventions applied to 
the network diagram.  Days Ahead (Behind) is calculated by dividing the schedule variance SV by the 
cost per day.  So the project appears, based on conventional EVA considerations, to be a little over 
budget and a little behind schedule. 
 

Let us look next at the concepts of planned value rate (PV Rate) and time variance (TV) in the 
context of this problem.  By definition, planned value rate is BAC/TAC = $198,000/21 = $9,428.57 per 
day.  Using the standard definition for time variance, TV = SV/PV Rate = -$12,000/$9,429 = -1.27 days.  
We conclude that the project is 1.27 days behind schedule.  Worthy of note is the fact that PV Rate is 
actually not a constant, but varies over the life of the project.  If the project runs on schedule, the 
planned value rate starts out (assuming an early start for all tasks) at the sum of the daily burn rates for 
activities A, B and C or $4,000 + $5,000 + $6,000 = $15,000.  After day 13, however, if the project runs 
on schedule, only activity D is underway with a daily burn rate of $7,000.  Thus, the planned value rate 
varies over time. 
 

Next, we shall look at the critical path for this project.  The critical path involves tasks C and D.  
Task C is well ahead of schedule.  Task D has yet to be started since only seven days have transpired 
and task C is 13 days in duration.  In fact the Days Ahead column of Table 12.2 suggests that C is 2.1 
days ahead.  If this is maintained, the project will finish two days early, roughly.  Notice, in Table 12.2, 
that the lateness of the non-critical tasks A and B does not interfere with task C finishing 2 days ahead.  
For the case of A, 2.4 of the seven days of slack are used up, leaving 4.6 net days of slack.  Similarly 
for task B, 3.0 of the five days of slack are used up leaving two days net. 
 

Based on conventional EVA considerations, this project would be reported to be both over 
budget and behind schedule, costing $25,000 additional (roughly) and taking almost 3 days longer.  
But, in fact, this project has a very good chance of finishing ahead of schedule. 
 

In this next example, a six-task problem is considered that is 12 days old. 
 



 

CHAPTER 12—PROJECT EXECUTION AND CONTROL…, COPYRIGHT 2016   JAMES R. BURNS.  ALL RIGHTS RESERVED P.16 

. . . . . . . . . 
 

 
 
Figure 12.8:  A Six-Step, Activity-on-Node Network (activity durations are numbers following forward 
slashes) 
 

For each of the six tasks that make up the project above, assume the following: 
 

TASK Percent Complete Expenditures/Day Actual Expenditures to Date 

A 100% $1,000 $10,000 

B 100% $1,200 $9,000 

C 80% $1,000 $4,000 

D 90% $1,500 $5,000 

E 20% $1,500 $3,000 

F 0% $1,000 $0 

 
Table 12.3:  Data Required for EVA Calculations of the Network Exhibited in Figure 12.8 above. 
 
From Table 12.3 above, it should be clear the budget for A is 8*1,000 or $8,000.  The project is 12 days 
old (12 business days have transpired), where the units on time are days.  Clearly, the BCWS for A is 
$8,000; the BCWP is also $8,000 because it is 100% complete.  The BCWS for C, however, is $4,000, 
while the BCWS for F is 0. 
 

 
TASK 

TOTAL 
BUDGET 

 
%COMP 

ACWP 
(AC) 

BCWS 
(PV) 

BCWP 
(EV) 

 
CV 

 
SV 

 
SPI 

 
CPI 

A $8,000 100% $10,000 $8,000 $8,000 -$2,000 $0 1.00 0.80 

B $10,800 100% $9,000 $10,800 $10,800 $1,800 $0 1.00 1.20 

C $7,000 80% $4,000 $4,000 $5,600 $1,600 $1,600 1.40 1.40 

D $9,000 90% $5,000 $4,500 $8,100 $3,100 $3,600 1.80 1.62 

E $13,500 20% $3,000 $4,500 $2,700 -$300 -$1,800 0.60 0.90 

F $5,000 0% $0 $0 $0 $0 $0 0.00 0.00 

Totals $53,300  $31,000 $31,800 $35,200 $4,200 $3,400 1.11 1.14 

 
Table 12.4:  Basic EVA Calculations for Network Exhibited in Figure 12.8 (inputs are shown in bold) 
 

In this problem, the BAC = $53,300, while the TAC = 23 (the length of the critical path).  From 
these numbers, EAC  = BAC/CPI= $53,300/1.14 = $46,754, while the ETAC = TAC/SPI = 23/1.11 = 
20.72.  This project appears to be both under budget and ahead of schedule. 
 

Let us look next at the concepts of planned value rate (PV Rate) and time variance (TV) in the 
context of this problem.  By definition, planned value rate is BAC/TAC = $53,300/23 = $2,317.39 per 
day.  Using the standard definition for time variance, TV = SV/PV Rate = $3,400/$2,317.39 = 1.47 
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days.  We conclude that on day 13, the project is 1.47 days ahead of schedule.  The PV Rate could be 
viewed not as a constant, but as a time function that varies over the life of the project.  If the project 
runs on schedule, the daily burn rate after 12 days (day 13 is the day of interest in this problem) is the 
sum of the daily rates for activities C, D and E (assuming an early start for all tasks) or $1,000 + $1,500 
+ $1,500 = $4,000.  Thus the planned value rate appears to be $4,000 on day 13, if it is allowed to vary.  
After day 18, however, if the project runs on schedule, only activity F is underway with a daily burn rate 
of $1,000.  Thus after day 18, the planned value rate appears to be $1,000, assuming it is allowed to 
vary over the life of the project. 
 

However, when we examine the critical path (B-E-F), we see that task E is well behind 
schedule.  In fact task E is a full 1.2 days behind.  It will, consequently, cause the entire project to be 
delayed.  Rather than finishing in 20.72 days (more than 2 days early) as EVA would predict, the 
project appears likely not to finish until 24.2 days have elapsed. 
 

What do these models show us?  These measures (the total project CV, SV, SPI, and CPI) 
should be examined from a path perspective.  Particular interest should be devoted to the critical path. 
 

In his 1997 novel Critical Chain, (Goldratt, 1997) Goldratt suggests that conventional tracking 
techniques are not very useful because they do not take into consideration the critical path.  The result 
is that, taken in aggregate, the schedule variance might suggest the project is ahead of schedule when 
in fact work on the critical path is behind schedule, or vice versa.  As Goldratt would be quick to point 
out, the main thing that matters is what’s happening on the critical path.  If the critical path is behind 
schedule while all other (non-critical) paths are ahead of schedule then EVA tells you incorrectly that 
the entire project is ahead of schedule.  This is the point of the simple illustrative models discussed 
above:  to provide definitive examples of how conventional tracking techniques do not provide the “total 
picture” with respect to project duration. 
 

From the examples we looked at above, certain observations are in order.  First, with respect 
to schedule, three states are possible:  the project is on schedule, the project is ahead of schedule, or 
the project is behind schedule.  When the critical path and the EVA are consistent and in agreement 
with respect to these states, there are no “problems;” i.e., when both indicate the project is on schedule, 
we can accept the verdict of both.  In all other, circumstances where there is disagreement, the state 
suggested by the critical path should dominate over that suggested by the EVA.  The reason behind 
this assertion is thus:  the critical path determines total project duration.  A partial solution to this 
problem is to require a late start for all paths that are non-critical, making all paths critical.  Doing so 
removes the slack on non-critical paths; it also makes the probability of a delayed project that finishes 
behind schedule much higher.  But a “late start solution” mitigates only the first of the two dilemmas 
discussed above, not the second.  Probabilistic project models will be taken up in the next section. 
 

Project Quality Control 

 
“Quality” is a word that is found in most advertising clichés.  Whether you are buying hamburgers or 
solid oak furniture, the operative word is “quality.”  Quality is also one of the most written about subjects 
in books, magazines, and Internet articles.  And, quality is one of the most talked about subjects in 
business seminars and conferences (Collins, 1987, p. 1).  It has been argued that quality is the world’s 
oldest documented profession.  This is found in Genesis 1:31:  “ . . . and God looked at all that He had 
made, and it was very good . . . .”  The creator of the earth did a first-article inspection of His work and 
declared that it had turned out just as He had planned (Collins, 1987, p. 2).  From the Creator’s point of 
view, the quality was perfect.  However, in today’s time, producing quality is usually thought of more in 
the business world of manufacturing.  When one produces quality, he or she must also utilize quality 
control.  The object of quality control is to create quality which:  satisfies the customer, is as cheap as 
possible, and can be achieved in time to meet delivery requirements.  Therefore, the objective is not to 
simply produce the highest quality but to satisfy the customer (Duncan, 1965, pp. 8-9).  The definition of 
quality control usually adopted is that:  “Quality control is the function or collection of duties which must 
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be performed throughout an organization in order to achieve its quality objectives” (Caplen, 1969, p. 
12).  There are various stages to quality control.  Some of the key stages include the following:  
conformance to requirements, prevention, zero defects, price of nonconformance, testing, correcting, 
and education of employees.  These key stages answer important management questions.  What is 
quality?  What system is needed to cause quality?  What performance standard should be used?  What 
measurement system is required? 
 

What is Quality Control? 

 
This question is a good one.  It provokes thought regarding whether or not a company is doing enough 
(and “enough” is a very subjective term) to control the quality of its products, processes and projects, 
and how the company may be able to improve its existing processes to either cut costs or reduce 
defects.  Before quality control can be defined, however, it is good to begin with a definition of quality: 
 
Quality is “a predictable degree of uniformity and dependability, at low cost and suited to the market” 
(Gitlow, 2001, p. 2). 
 

Now, what does this mean exactly?  It means several things.  The quality of your product 
determines whether or not your customers will look elsewhere for something better.  If your product has 
poor quality, then one or more components in your value-chain are not performing to their full capacity.  
This could be due to a design flaw, a mechanical problem, or incompetent staff.  Such problems are 
usually easy to determine, upon a thorough analysis of the value-creation process.  Fixing them 
correctly, however, can take a tremendous amount of time and capital to achieve.  The lesson learned 
here is simple:  make sure that a very thorough analysis is performed of the entire process before 
production is started, as the sooner a defect is caught, the more quickly, easily and inexpensively it can 
be rectified.  Some of the world’s best known corporations have lost millions, even billions, on defective 
products that could have been avoided if more testing and analysis had been done prior to launch.  The 
further down the product lifecycle that a defect is discovered, the more expensive it will be to fix.  If the 
defect is found internal to the firm it is far less expensive to fix than once the product is set into 
operation outside the firm, where there can be liabilities as a result of loss of assets, property or human 
life that can result. 
 

The first key stage of quality control is conformance to requirements.  In order to accomplish 
this stage, management must perform three basic tasks:  first, establish the requirements that 
employees are to meet; second, supply the resources that the employees need in order to meet those 
requirements; and third, spend time encouraging and helping the employees to meet those 
requirements (Crosby, 1984, p. 61).  This helps employees operate to standards other than experience 
and opinion.  Simply stated, the best brains and most useful knowledge will not be used in fixing a 
problem or smoothing over coarse edges; instead, they will be used in establishing the requirements in 
the first place. 
 

Prevention receives high priority within quality control.  Prevention is something we know how 
to do if we understand the process.  This type of thinking is basically commonsense.  For example, if a 
courier is driving to an unknown destination, it is best to ask for directions before driving out to the new 
location.  This is a simple example, but this thinking can be applied to any business situation.  A 
method to help this thinking is called statistical quality control, or SQC.  SQC is the application of 
statistical techniques for measuring and improving the quality of processes.  SQC includes statistical 
techniques for measuring and analyzing the variation in processes, diagnostic tools, sampling plans, 
and other statistical methods (Juran, 1988, p. 24.2).  Under the SQC method, each variable in the 
process is identified and is measured as the process continues.  If all the variables are inside their 
“control limits,” then the end result should be what was planned to begin with (Crosby, 1984, p. 70).  If 
not, the process is stopped, diagnosed, and corrected as necessary before being restarted.  There are 
many other theories to use when practicing prevention.  Analysis of variance, regression and 
correlation, and random sampling are examples of other methods used (Duncan, 1965, pp. 20-45). 
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The practice of zero defects (ZD) is a well-known key stage to quality control.  A company is 
made up of millions of actions that come together to make up the whole process or plan.  Every little 
action has to be done right in order for the process to come out correct.  Phillip Crosby (1984) vividly 
describes the zero defect method as follows: 
 

People are carefully conditioned throughout their private life to accept the fact that 
people are not perfect and will therefore make mistakes.  By the time they seek an 
industrial life, this belief is firmly rooted.  It becomes fashionable to say, “People are 
humans and make mistakes.  Nothing can ever be perfect as long as people take part 
in it,” and so it goes . . . Mistakes are caused by two factors:  lack of knowledge and 
lack of attention.  Knowledge can be measured and deficiencies corrected through 
tried-and-true means . . . Lack of attention is an attitude problem.  The person who 
commits himself or herself to watch each detail and carefully avoid error takes the 
gain step toward setting a goal of Zero Defects in all things (pp. 82-83). 

 
Careful communication and planning are ways to establish this ZD thinking.  Management 

should train employees to be cautious and aware of problems that might arise and to not accept any 
such problems or errors.  Diagnostic tools to help find these errors are discussed under “Tools for 
Quality Control.” 
 

One measurement of quality is the price of nonconformance.  Cost of quality can be divided 
into two areas.  These areas include the price of nonconformance (PONC) and the price of 
conformance (POC).  Prices of nonconformance are the expenses involved in doing things wrong.  For 
example, this would include the cost to correct a sales clerk’s order when they come in, to do any type 
of work over, or to pay for warranty and other types of nonconformance claims (Collins, 12).  If one 
were to sit down and add all these amounts up, he or she would come up with a huge amount of 
money.  This represents twenty percent or more of sales in manufacturing companies and thirty-five 
percent of operating costs in service companies.  Price of conformance is what is necessary to spend 
to make things come out right.  An example would be prevention efforts and quality education.  This 
only comes out to three to four percent of all sales in a well-run company.  Management can come up 
with a number or price of nonconformance and then come up with a procedure that can be used 
forever.  The price can then be used as a total to track whether the company is improving, and as a 
basis for finding where the most beneficial corrective-action opportunities dwell.  Another method that is 
popular among companies is to use indexes and charts to measure results in quality control systems. 
 

Testing is an imperative stage of quality control.  One way to assure the product or process is 
in “control” is to predict consumer acceptance.  There are several ways to do this.  Finding consumer 
likes and dislikes, performing consumer preference testing, and performing consumer sensitivity testing 
are all ways to test consumer acceptance.  One approach to prediction of consumer acceptance of a 
new product is to secure data on consumer likes or dislikes.  A test is submitted to potential, numerous 
users.  Their responses are secured on a “hedonic” scale.  The scale contains (1) like very much, (2) 
like, (3) neither like nor dislike, (4) dislike, (5) dislike very much.  Looking at the patterns on the scale 
summarizes the data on the hedonic scale.  Another approach is consumer preference testing is used 
to discover preference.  In competitive markets, such preference tests can give useful guides to 
decisions on product marketability, pricing, etc.  In order to do this there needs to be two or more 
samples.  The responses are “forced” by choosing A or B.  Consumer sensitivity testing is another 
testing method.  Its purpose is to discover the “threshold” level at which consumers can detect the 
existence of sensory qualities.  The qualities under this test may be either desirable or undesirable.  A 
graduated set of samples is prepared.  These samples include new products that are under 
examination.  The consumers are shown a certain product and asked to inspect it.  Their response is 
then plotted on the sample graph.  This testing goes along with the saying “the consumer is always 
right.”  These three testing methods help to show the company if their product is in “control” enough to 
put out on the market. 
 

Another key stage to quality control is correcting.  Unfortunately, life being what it is, people do 
not always achieve perfection.  One must use corrective measures with the object of learning from 
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mistakes, so to avoid that fault in the future.  The first step in correcting is to identify what went wrong 
and correct it.  One can do this by analyzing the statistical control charts (SQC) that were used in the 
prevention stage.  From the control charts, one should be able to infer which operations or tasks must 
be responsible.  The next step to correcting is to analyze the “scrap” or rework itself.  As mentioned 
earlier in the zero defects discussion, the diagnostic tools to help find errors are the matrix, Pareto 
analysis, and time-to-time analysis (Juran, 1988, 22.54).  The Pareto curve (discussed later in the 
Chapter) is a very popular method to use in this stage.  The last part of the correcting stage is to set 
rules to follow so every employee knows when to make changes.  For example, “any process making 
more than 5 percent scrap should be examined” is a rule every employee can follow.  By following 
these three steps, anyone can correct any shortcoming of a process (Caplen, 1969, pp.194-208). 
 

In order to launch quality control, education at every management level must be implemented.  
Education is a vital key component in quality control.  When a service organization embarks on a 
comprehensive quality effort, each step in the process of designing and developing a quality program 
needs to be communicated clearly.  All levels of the company are informed about the purposes of and 
need for quality control, and their individual roles in the efforts are defined (Juran, 1988, pp. 33-40).  To 
make a hassle-free, prevention-oriented company requires that everyone really know what is involved.  
Each and every person in the company must understand every individual’s role in causing quality.  
Those involved with a specific function have to have special education in order to carry out their roles.  
The overall education aspect requires executive education, management education, and employees’ 
education.  The purpose of executive education is to help senior people understand their role in 
causing problems and then causing improvement in the quality process.  Executives need to 
understand what everyone else is going to be taught; they need to understand what they can do to 
encourage the control and improvement process as well.  Because they are the “big-wigs” of the overall 
management, everything they do is important and watched.  Management education should include 
material on communication skills and presentation skills.  Without these skills, managers can never find 
out where the underlying quality problems are or how to tell the rest of the company how to correct 
these problems.  Employee education comes from managers usually.  They should be taught what 
quality is and how they can individually control quality.  They must also take this education and apply to 
their job.  Education is very important because every person on the project can then work together on 
what they have learned and produce the finished process or product they want (Crosby, 1984, pp. 91-
99). 
 

Certainly, no one expects a process’s quality to stay in “control” at all times.  After all, mistakes 
are a part of life.  Because of this, there are key rules for businesses to follow that deal with maintaining 
and establishing quality control.  Conformance to requirements, prevention, zero defects, price of 
nonconformance, testing, correcting, and education of employees are all the important stages.  Quality 
control deals with management issues and statistical issues.  Conformance to requirements and 
education of employees both deal with management issues.  Prevention, zero defects, price of 
nonconformance, testing, and correcting all have some statistical issues that help to maintain quality 
control.  By using all these rules, any project should be able to keep their quality in control. 
 

TOTAL QUALITY CONTROL THEORY AND STANDARDS 

 
This section will discuss the work of quality control pioneer W. Edwards Deming and his Total Quality 
Control (TQC) theory, discuss quality standards, perform case studies on several large players in the 
semiconductor chip manufacturing industry, summarize these findings, and conclude with several 
opinions on the importance of quality control and how it will change in the future. 
 

Deming's Pioneering of Total Quality Control Theory 

 
W. Edwards Deming is one of the true pioneers in the field of quality control.  Receiving a doctorate in 
mathematical physics from Yale University in 1928, Deming went on to achieve great success by using 
statistical processes to develop new ways to produce and develop products.  He instructed engineers 
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on how to use statistics to improve production of war supplies, during World War II.  After the war had 
finished, Deming traveled to Japan to show Japanese engineers his methods of quality control, and 
how they could use his methods to improve production and achieve greater profits.  Some of the 
Japanese wisely used his teachings to achieve great profitability in the post-war depression that Japan 
faced. 
 

With these achievements alone, Deming could be thought of as a true American, one who 
worked hard to become successful and used his gifts to help others.  Deming’s greatest achievement in 
the field of statistical modeling, however, was yet to come.  In 1951, Deming unveiled a new way of 
thinking about quality control:  a term known as “Total Quality Control” (also known by many as Total 
Quality Management, or TQM).  Total Quality Control, or TQC for short, was a revolutionary new way of 
thinking about how quality was measured in an organization.  It emphasized the “joy in work,” and 
detailed how quality should be checked for at every step in the process, not merely at the completion 
(Gitlow, 2001). 
 
How did Deming propose to check for quality at each step?  Deming described three types of quality to 
be measured in the workplace.  They are the quality of design, quality of conformance, and quality of 
performance. 
 
The Quality of Design focuses on developing products with a customer orientation.  They center on 
determining the quality characteristics of products or services that are suited to the needs of the market.  
Much customer research should be performed in design to accurately know what consumers are 
seeking in the product(s) they buy.  The process of Quality of Design is an ongoing one; it is constantly 
evolving through time, just as consumers’ preferences and needs change over time. 
 
The Quality of Conformance answers the question, “How consistent is the company in producing a 
quality product?”  Once the Quality of Design has been established, the Quality of Conformance is 
needed to exceed the specifications of the design stage.  A company’s Conformance shows how good 
it is at producing uniform, dependable products at a set cost (specified in the design stage). 
 
Finally, the Quality of Performance is used by a firm to determine how well its products are actually 
performing in the marketplace.  Much of the research in this step comes from sales/service call analysis 
and consumer research.  A company that has a loyal consumer base but is experiencing difficulty 
selling a new product may want to review the performance of the product to check for noticeable 
defects or design flaws that may have been missed previously. 
 

Quality Control Measurement 

 
As explained above, firms must want to meet or exceed their own quality control requirements if they 
are to remain successful in their industry.  However, in addition to the internal quality requirements that 
they must meet, they also must comply with established guidelines for the industry.  In 1994, a new 
certification standard was unveiled that companies in many industries strived to achieve:  ISO-9000. 
 

ISO-90006 

 
ISO-9000 consists of five specific standards, which are each classified as either a conformance model 
(a standard that your organization must conform to become certified) or a guide (a set of 
recommendations to help the organization meet a conformance model).  Each of the five standards are 
listed below, along with a brief description of what each standard entails. 
 
1. ISO-9001 – This standard includes measuring quality assurance in design/development, 
production, installation, and servicing. 

                                                      
6 ISO stands for International Orgainzation for Standardization and consisted originally of the twelve countries that 

made up the European Union—Belgium, Denmark, France, Germany, Ireland, Italy, Luxemburg, the Netherlands, 

Portugal, Spain, and the United Kingdom. 
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2. ISO-9002 – ISO-9002 details how an organization should perform in quality assurance of 
production, installation, and servicing.  ISO-9002 does cover the installation and servicing just like ISO-
9001, but ISO-9002 is designed for organizations that do not participate in any design or development 
activities. 
3. ISO-9003 – ISO-9003 is responsible for measuring quality assurance in final inspection and testing 
of a product. 
4. ISO-9004 – ISO-9004 is the first of two sets of guidelines of the standard.  It covers selection and 
use of the standards of quality management, quality system elements, and quality assurance. 
5. ISO-9005 – The final standard of ISO-9000.  ISO-9005 is another set of guidelines that focuses on 
quality management and quality system elements. 
 

An organization chooses to have its quality system certified against either ISO-9001, ISO-
9002, or ISO-9003, depending on the business processes it performs and which standard relates to 
them.  There is no difference in ranking between the three standards. 
 

In ISO-9000, there are twenty sections that measure different activities in the organization.  A 
few of the more significant ones are described below. 
 
Contract Review – How well is your response to a customer’s request for a proposal for a project?  
Are the product’s specifications completely and accurately detailed in the response?  These are a few 
questions that pertain to Contract Review.  It ensures that organizations know how to respond and 
negotiate a contract sufficiently with vendors. 
 
Document and Data Control – How well does your organization control and manage important 
documents and data related to a project?  Is the information able to be accessed rather easily and is it 
complete and accurate?  An organization should have good document/data accessibility, and methods 
for dealing with the different types of information that the organization will come across in its operations. 
 
Inspection and Testing – Does incoming product meet specified requirements?  Is the product being 
produced inspected and tested as necessary?  Inspection and testing ensures that the organization is 
inspecting/testing products upon receipt, during processing, and after production has finished. 
 
Internal Quality Audits – Does your organization have an internal quality audit plan?  What corrective 
actions are taken on deficiencies found in the audit?  The Internal Quality Audits section verifies that the 
organization is performing internal quality audits that meet standards followed by industry leaders and 
the ISO-9000 spec. 
 

In conclusion, ISO-9000 is highly regarded as one of the top certifications available to any 
company in the business world today.  While it may take years to perform the entire certification 
process, a company that gains the ISO-9000 certification is not only given a strong competitive 
advantage over rivals who may not have it, but also assured that its own internal processes are of the 
highest possible quality found in their industry. 
 

Tools for Quality Control 

 
Many technical tools are used to create quality control; some of these that will be described later in 
detail are the Pareto charts, cause and effect diagrams, check sheets, flow charts, control charts, 
histograms, and scatter diagrams.  These tools can be used in reducing the process variability or to 
identify specific problems in the process of the project.  Although these tools may be helpful in order to 
ensure quality control, they do not constitute a quality program.  The program you establish for quality 
needs to promote quality in all aspects of its operations. 
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Pareto Charts 
 
Pareto charts are extremely useful because they can be used to identify those factors that have the 
greatest cumulative effect on the system, and thus screen out the less significant factors in an analysis.  
Ideally, this allows the user to focus attention on a few important factors in a process.  They are created 
by plotting the cumulative frequencies of the relative frequency data (event count data), in descending 
order.  When this is done, the most essential factors for the analysis are graphically apparent.  From 
the Pareto chart it is possible to see that the initial focus in quality improvement should be on reducing 
the largest characteristic. 
 

 
Figure 12.9:  Pareto Chart 

 
From Figure 12.9, we learn that 70% of the defects come from edge flaw and print quality.  

The Pareto chart is named after an Italian economist who used it for studying the wealth of Italy.  The 
Pareto curve is also sometimes called the 80/20 curve, because it is often found that some 80 percent 
of the defective work comes from only 20 percent of the causes.  To establish a Pareto curve, a 
percentage scale is drawn vertically where 100 percent means all the defective work made during this 
period.  Horizontally, a list of the reasons why the work was defective is drawn, starting with the most 
numerous types and then going down in descending order. 
 
Cause and Effect Diagrams 
 
Cause and Effect Diagrams also called Fishbone Diagrams are used to associate multiple possible 
causes with a single effect.  Thus, given a particular effect, the diagram is constructed to identify and 
organize possible causes for it.  The primary branch represents the effect (the quality characteristic that 
is intended to be improved and controlled) and is typically labeled on the right side of the diagram.  
Each major branch of the diagram corresponds to a major cause (or class of causes) that directly 
relates to the effect.  Minor branches correspond to more detailed causal factors.  This type of diagram 
is useful in any analysis, as it illustrates the relationship between cause and effect in a rational manner 
thus enabling quality to be represented in the delineation of causal factors.  An example of fishbone 
diagram for edge flaws is presented in Figure 12.10. 
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Figure 12.10:  Fishbone or Cause and Effect Diagram for Edge Flows 

 
Check Sheets 
 
Check sheets represent the information in a graphical representation that is easily understood.  
Basically, it is a list of different problem sources (causes).  Users can record the problems they come 
across.  Therefore, when looking back at specific processes you are able to determine where your 
problem areas may be occurring.  Then, once you have identified the problems, you will have a better 
chance at being able to create a way to decrease the amount of defects you come across in the 
specific process.  Figure 12.11 shows an example of check sheets. 
 

 

 
Figure 12.11:  Sample Check Sheets 
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Flowcharts 
 
Flowcharts are an illustration of the sequential steps that comprise a process.  By breaking down the 
process into its elemental steps, you are able to follow the steps in the process in order to identify 
where errors are likely to be made.  These can be helpful in maintaining quality control because if you 
can predict the steps in the processes where you are most likely to have errors, then you will be able to 
find the actual source of the error and remove the problem.  Flowcharts can be used as diagnostic tools 
in quality control, but they have many other uses as well.  Figure 12.12 is an example of plastic tag 
production flowchart. 
 

 
Figure 12.12:  Plastic Tag Production Flowchart 

 
Control Charts 
 
The control chart, as shown in Figure 12.13, is the fundamental tool of statistical process control, as it 
indicates the range of variability that is built into a system (known as common cause variation).  Thus, it 
helps determine whether or not a process is operating consistently or if a special cause has occurred to 
change the process mean or variance.  The bounds of the control chart are marked by upper and lower 
control limits that are calculated by applying statistical formulas to data from the process.  Data points 
that fall outside these bounds represent variations due to special causes, which can typically be found 
and eliminated.  On the other hand, improvements in common cause variation require fundamental 
changes in the process.  Thus quality is encompassed within the conception of a control chart. 
 

 
Figure 12.13:  Control Chart 
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Histograms 
 
Histograms provide a simple, graphical view of accumulated data, including its dispersion and central 
tendency. In addition to the ease with which they can be constructed, histograms provide the easiest 
way to evaluate the distribution of data.  Deviations from a normal distribution in a histogram suggest 
the involvement of additional influences in the process.  An example of frequency histograms is 
displayed in Figure 12.14. 
 

 
Figure 12.14:  Frequency Histogram 

 
Scatter Diagrams 
 
Scatter diagrams, the last of the quality control tools, are graphical tools that attempt to depict the 
influence that one variable has on another.  A common diagram of this type usually displays points 
representing the observed value of one variable corresponding to the value of another variable.  Figure 
12.15 is presented a scatterplot of defects and curetime. 
 

 
Figure 12.15:  Scatterplot of Defects vs Curetime 

 
One reason we use quality control is to ensure that a project’s activities take place as they 

were intended to, which is especially needed in the IT field since it has such a high failure rate.  The 
use of quality control within a project will help to deliver a product that has all of the capabilities and 
supporting features needed in an effective and timely manner and without defects.  These diagrams 
become very helpful in identifying problems in order to keep the project in control.  Many companies 
use prescribed templates or reports to regularly report quality issues.  In addition to diagrams and 
reports, companies schedule weekly meetings to communicate with the rest of the project team and the 
PM their progress and any risk or quality problems they have come across.  Meetings and reports were 
discussed in Chapter 11 along with other communication concerns. 
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Case Studies in Quality Control 

 
The case studies, we will concentrate on include HEB and several large firms in the semiconductor 
manufacturing industry:  Motorola, Intel, and AMD. 
 

HEB’s Use of Quality Control 

 
H.E. Butt Grocery Company, one of the largest regional food retailers in the United States, has its 
headquarters in San Antonio, Texas.  The main areas HEB focuses on when it comes to quality control 
is: 
 
When do you report progress? 
 
HEB uses two kinds of reporting methods.  They have Standard Reporting which consists of a weekly 
Project Status Report, a bi-weekly Project Activity Report and a monthly Project Assessment.  The 
second method is a Relaxed Reporting Method that skips all weekly or bi-weekly reporting and reports 
the Project Status Report and the Monthly Project Assessment monthly. 
 

A Project Status Report (PSR) is a deliverables-based schedule of the project.  This report 
shows when deliverables from the project will be completed.  It also breaks the project into phases.  In 
this report specific dates are not assigned for deliverables occurring after the current phase; dates for 
deliverables produced in the next phase are determined only after the current phase is completed.  
HEB has chosen this type of reporting because they believe it is easier to understand than MS Project.  
They also believe that this report gets to the “essence of the Project” since it mainly focuses on 
deliverable due dates.  In order to maintain control with the project, once they have begun work on the 
current phase they cannot change any dates within that phase without consulting with the PM by using 
a Change Request Form.  A Project Activity Report (PAR) is used to communicate progress with the 
key stakeholders.  HEB calls this report “The Heartbeat of the Project.”  This report states the monthly 
progress of the project. It lists all of the deliverables that have reached completion and warns project 
team members of what critical dates and milestones are coming up next.  This report will also list any 
new issues or risks that have come up since the start of the project. 
 

A Monthly Project Assessment (MPA) is used to give a more detailed look at the triple 
constraint (Time + Cost + Scope = Quality).  The MPA alerts the project team and the PM of the 
project’s status and concerns.  It is also used to study trends within the company to define areas that 
may need more action for correction. 
 
Who needs to know about the Project? 
 
HEB believes that anyone who will participate in the development of the project or is accountable in any 
way for the project should know about the project.  This means, in order to ensure quality, everyone 
needs to be informed. This may extend out to such people as the Financial Advisors, the Technical 
Experts, and of course the Executive Sponsor.  The key to a successful project is having everyone on 
the same path.  Everyone should be aware of what and when things are expected and the budget 
assigned for each of these tasks. 
 
How do we raise concerns/issues? 
 
Since every successful project runs across concerns and issues it is important to know how to deal with 
them when you come across one.  HEB deals with this by including in their reports a place to address 
new concerns or risks that have been discovered while working on the project.  They also address this 
in their weekly meeting so they are able to quickly resolve any new concerns a team member or a 
stakeholder might hold.  Having the ability to quickly communicate and resolve concerns and issues 
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allows for the project to stay in better control, because you address such problems before they become 
out of control and out of your ability to quickly fix them within your allotted time and budget. 
 
How are we measured? 
 
Now the question is how do you measure if the project is successful or if it is on a successful path. Well, 
HEB measures this by using their Key Success Factors (KSF).  They use a scale-like system to 
determine how successful their project will be.  For example, each project deliverable that is completed 
and delivered by the scheduled deadline will receive the highest rating for success. Then after that it will 
decrease.  For instance, if a deliverable will be completed in less than 15% behind schedule, they will 
receive a medium rating.  Then it will decrease once again if it is more than 15% behind schedule.  
They will also receive the same kind of rating to determine how successfully they stay within their 
budget.  Therefore when the project is completed and all of the deliverables have been turned in, they 
can examine their success chart and determine how successful they were at achieving the project in an 
effective and efficient manner. 
 

Motorola, Inc. 

 
As a world leader in the semiconductor industry, Motorola has proven that they possess the skills and 
ability to fabricate some of the world’s most advanced chips.  Many of their chips power Apple 
computers, Motorola cell phones and pagers, and automotive/industrial products. 
 

Motorola itself is no stranger to producing high-quality products.  In 1988, Motorola was 
awarded the first ever Malcolm Baldridge award by the National Institute of Standards and Technology.  
This award was given to the company because of an unprecedented improvement in the size of wafer 
yields produced.  At the time, many companies were practicing what was known as “Three Sigma.”  
Three Sigma was a mathematical expression designating that in a company’s manufacturing line, the 
company expected to run into several defects per thousand units produced.  At this time, Motorola was 
just beginning to practice “Six Sigma,” which means that defects are limited to a few per million or even 
per billion!  This was such a huge step in the right direction of quality processes that Motorola actually 
gained a competitive advantage through its Six Sigma practice.  Other companies in the industry 
realized that as time passed and semiconductors became more and more advanced, with more and 
more transistors, that a higher quality process would be needed to keep up with the technology.  In this 
aspect, Motorola led the way for other companies to follow. 
 

At www.motorola.com, there is a rather interesting page that details the company’s “Six Steps 
of Quality.”  First, a Customer Needs Analysis and Network Design is performed.  Motorola’s 
technologists will completely analyze the information flow in the organization and develop a preliminary 
plan to improve the dissemination of information.  The second part of the process is to develop an 
Implementation Plan, perform Equipment Integration and Factory Testing.  This phase involves 
procuring all of the equipment for the company and sending it to Motorola’s Customer Center for 
Systems Integration to be rigorously tested and integrated. 
 

The third step is Site Preparation/Equipment Testing.  Motorola works with local 
subcontractors in this step to ensure that their site meets government/environmental regulations and is 
well equipped to handle the new equipment.  Next comes Optimization and Commissioning.  Motorola 
engineers perform quality audits and verify network connectivity at the site to ensure that the network is 
capable of handling the new technology.  The fifth step of the process is Team Training.  Motorola 
provides certification programs to help develop the project team to perform at their best.  They also 
provide instruction to in-house trainers, giving them control of their employee’s education.  The final 
phase of Motorola’s Six Steps of Quality is Continuous Support.  If your project should experience a 
hardware failure, Motorola will quickly work with them to help get the project back on its feet with 
minimal downtime.  Some of the methods include Technical Phone Support, Remote Diagnostics, and 
Field and Dispatch Services. 
 

http://www.motorola.com/
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Motorola has committed itself to providing high-quality semiconductors to meet the needs of 
changing technology in this information age.  With over 60 years of experience in the manufacturing 
industry, Motorola will surely be leading technological growth through the 21st century. 
 

Intel Corporation 

 
The leading producer of PC-compatible microprocessors and chipsets, Intel is no stranger to 
technology.  In 1965, an Intel scientist named Gordon Moore noticed something unique about how 
often the company was adding transistors to its chips.  He observed that each 18-24 months, a new 
processor was released that doubled the existing capacity (in transistors) of the current chip.  Termed 
Moore’s Law, the observation is still valid today.  The Pentium II processor contains over 7.5 million 
transistors, quite an increase from the 2,300 transistors found in Intel’s original 4004 processor (which 
pre-dated the 8086). 
 

Aside from that interesting fact, Intel itself is also no stranger to quality products.  In the 
company’s “Intel Quality Culture” document, Intel describes a “total quality culture” that they strive to 
facilitate.  They seek to: 
 
1.  Continuously improve the customer-perceived value of our products, processes and people (work 
better). 
2.  Continuously reduce the time it takes to perform every activity (work faster). 
3.  Continuously reduce the total cost of doing business (work cheaper). 
 

To help to implement these behaviors, the company regularly awards exceptional progress 
made by employees.  The Intel Achievement Award is given to individuals or small teams that make a 
large contribution to the company’s operations. 
 

Similar to Motorola’s Six Steps to Quality, Intel has its own “Seven Steps of Problem Solving.”  
They consist of: 
 
1. Define the Problem 
2. Clarify the Current Situation 
3. Analyze Causes 
4. Develop Solutions 
5. Validate Solutions 
6. Embed Solutions 
7. Determine the Future Direction 
 

This is a small part of Intel’s approach to continuous improvement.  Other important steps 
include Process Management, Human Resource Management, Monitoring Business Results, 
Leadership/Strategic Planning, and Market Focus.  All of these are significant contributors to the overall 
success of the company, and must be followed closely to ensure that the company yields the results 
they desire.  Intel has enjoyed tremendous success through the years.  Its microprocessors have 
dominated the PC industry for many years, and Intel’s constant focus on quality planning and control is 
vindicated by their success in the marketplace. 
 

Advanced Micro Devices, Inc. 

 
Advanced Micro Devices, or AMD, has been competing with Intel for years.  Recently, they have begun 
to become a serious threat to Intel’s PC market dominance.  AMD has shown that they possess the 
technical knowledge and creativity to succeed in this competitive market.  They were the first to reach 
clock speeds of 1Ghz, and this accomplishment gave them ample media exposure, propelling AMD 
into the spotlight.  Their Athlon processor provides superior performance at a competitive price. 
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AMD has not succeeded through the years without measuring their output quality.  The 
company’s quality manual states:  "AMD is committed to excellence in all its operations." (4-0, section 
1).  The company has six core values that it retains, despite the changing external environment.  They 
are: 
 
1. Respect for People.  The company and its employees must respect equally other employees, the 
company’s customers, and treat everyone fairly. 
2. Integrity and Responsibility 
3. Competition.  AMD believes that competition drives the marketplace and is beneficial to 
technological growth. 
4. Knowledge 
5. Initiative and Accountability 
6. Our Customers’ Success.  AMD wants its customers to be successful in their endeavors, and AMD 
provides the technology that companies need to excel in business. 
 

Summary 

 
Scope Change Control 
 
Ideally, project managers would prefer frozen requirements when projects start executing.  However, 
scope changes might be necessary due to several reasons, i.e., market conditions changes, forces 
from new competitors, customers’ requests.  A scope change control process involving a combination 
of procedures, responsibilities, and systems should be defined and implements when changes are 
requested. 
 
Schedule Control 
 
Schedule control ensures that projects are finished on-time.  Timeliness often becomes paramount in 
any environment in which time is the most important priority.  Often you will hear managers say, I’d 
rather have the product partially complete rather than have it late.  In such environments, time is of the 
essence and getting the product out on schedule is of utmost importance. 
 
Cost Control 
 
It is self-evident that cost control goes far beyond any simple three-line definition.  In order for cost 
control to be effective, there are many processes and steps that need to be followed.  One might start 
learning more about cost control by learning the basics, who is involved in controlling costs, 
establishing targets, warning signs, and the major job tasks of a control cost engineer and a project 
manager. 
 
Quality Control 
 
In the semiconductor industry, or in any industry for that matter, quality should be the number one 
priority.  Without well-performing products and services, a company has no chance of long-term 
survival.  The case studies in this chapter have summarized what Motorola, Intel, and AMD are doing to 
ensure that their products are of the highest quality, and that they continue to be a competitive force in 
their environment.  Only time will tell if new firms will appear that threaten to steal their market share. 
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Chapter 12 -- Exercises 

 

1.  Define what is meant by: 
 

Actual Cost, AC  
Actual Cost of Work Performed, ACWP 
Budget at Completion, BAC 
Budgeted Cost of Work Performed, BCWP 
Budgeted Cost of Work Scheduled, BCWS 
Earned Value, EV 
Estimated Cost at Completion, EAC 
Estimated Time at Completion, ETAC 
Multitasking 
Planned Value, PV 
Quality Control 
Safety 
Schedule Control 
Scope Change Control 
Single-tasking 
Student Syndrome 
Time at Completion, TAC 

 
2.  Name and briefly describe the seven stages to quality control.  Which of these have statistical 
aspects or issues?  Which have management aspects or issues? 
 
3.  Deming described three types of quality to be measured in the workplace.  What are they? 
 
4. 

 
 
Consider the network involving four activities as shown above.  Activity A requires 60 days to complete 
at $800/day.  Activity B requires 90 days to complete at $1,000/day.  Activity C requires 120 days to 
complete at $500/day.  Currently, the project is in its 70th day of operation.  Activity A is 70% complete, 
B is 60% complete and C is 70% complete.  So far, $50,000 has been spent on A, $40,000 on B and 
$30,000 on C, and nothing on D.  Determine:  BCWP, BCWS, ACWP, CV, SV, CPI, SPI.  What about 
cumulative earned value, taken in relation to cumulative cost?  Is this project behind or ahead of 
schedule, over or under budget?  Is the project likely to be completed by its due date?  Why or why 
not? 
 
 

A

B

C

D

A

B

C

D
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5. 

 
 
In the above, assume tasks A, B and C all started six business days ago.  Planned durations are in 
days and are the numbers in the boxes shown above.  A is 80% complete, B is 50% complete and C is 
70% complete.  So far, $,2000 has been spent on A, $3,000 on B, $4,000 on C, and nothing on D.  The 
budgeted daily costs for A, B, C and D are $400, $500, $700 and $500, respectively.  The total budget 
for A is 6*$400 or $2,400.  To determine BCWS, assume six working days have transpired.  Assume 
five-day work weeks, with no work being done on Saturday or Sunday.  For example, the BCWS for A 
is $2,400.  Determine for A, B, C and D, BCWP, BCWS, ACWP, CV (= BCWP – ACWP), SV (= BCWP 
– BCWS), CPI and SPI.  Complete the following table. 
 

TASK TOTAL 
BUDGET 

%COMP ACWP 
(AC) 

BCWS 
(PV) 

BCWP 
(EV) 

CV SV CPI SPI 

A          

B          

C          

D          

Totals          

 
Is the project ahead of or behind schedule?  Is the project over or under budget?  Will the entire project 
be early or delayed?  What is the BAC, Budgeted Cost at Completion?  What is the EAC, Estimated 
Budget at Completion?  What is the Estimated Time to Complete the project, ETAC, assuming an 
existing completion TIME of 22 days? 
 
6.  A project has three activities that have been budgeted and scheduled.  A fourth activity succeeds 
the first three.  The network diagram is shown below. 
 

 
 
In the above, assume tasks A, B and C all started seven business days ago.  Planned durations are in 
days and are the numbers in the boxes shown above.  A is 80% complete, B is 50% complete and C is 
70%.  So far, $2,000 has been spent on A, $3,000 on B, $4,000 on C, and nothing on D.  The 

A/6

B/9

C/13

D/8

A/6

B/9

C/13

D/8

A/9

B/5

C/7

D/0

A/9

B/5

C/7

D/0
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budgeted daily costs for A, B, C and D are $400, $500, $700 and $500, respectively.  The total budget 
for A is 6*$400 or $2,400.  To determine BCWS, assume seven working days have transpired.  
Assume five-day work weeks, with no work being done on Saturday or Sunday.  For example, the 
BCWS for A is $2,800.  Determine for A, B, C and D, BCWP, BCWS, ACWP, CV (= BCWP – ACWP), 
SV (= BCWP – BCWS), CPI and SPI.  Complete the following table. 
 

TASK TOTAL 
BUDGET 

%COMP ACWP 
(AC) 

BCWS 
(PV) 

BCWP 
(EV) 

CV SV CPI SPI 

A          

B          

C          

D          

Totals          

 
Is the project ahead of or behind schedule?  Is the project over or under budget?  Will the entire project 
be early or delayed?  What is the BAC, Budgeted Cost at Completion?  What is the EAC, Estimated 
Budget at Completion?  What is the Estimated Time to Complete the project, ETAC, assuming an 
existing completion TIME of 22 days? 
 
7. 

 
 
In the above, assume tasks A, B and C all started seven business days ago.  Planned durations are in 
days and are the numbers in the boxes shown above.  A is 80% complete, B is 50% complete and C is 
70% complete.  So far, $20,000 has been spent on A, $30,000 on B. $40,000 on C, and nothing on D.  
The budgeted daily costs for A, B, C and D are $4,000, $5,000, $6,000 and $7,000, respectively.  The 
total budget for A is 6*$4,000 or $24,000.  To determine BCWS, assume seven working days have 
transpired.  For example, the BCWS for A is 6*$4,000 or $24,000, since it should be finished.  The 
BCWS for B is 7*$5,000 = $35,000.  Assume five-day work weeks, with no work being done on 
Saturday or Sunday.  Determine for A, B, C and D, BCWP, BCWS, ACWP, CV (= BCWP – ACWP), 
SV (= BCWP – BCWS), CPI and SPI.  Complete the following table. 
 

TASK TOTAL 
BUDGET 

%COMP ACWP 
(AC) 

BCWS 
(PV) 

BCWP 
(EV) 

CV SV CPI SPI 

A          

B          

C          

D          

Totals          

 
For the above table and network, determine BAC, EAC, TAC, ETAC.  Comment on whether this project 
is behind schedule, ahead of schedule, over or under budget. 
 
 

A/6

B/9

C/13

D/8

A/6

B/9

C/13

D/8
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8. 

 
 
In the above, assume tasks A, B and C all started five business days ago.  Planned durations are in 
days and are the numbers in the boxes shown above.  A is 60% complete, B is 50% complete and C is 
70% complete.  So far, $8,000 has been spent on A, $3,000 on B, $6,000 on C, and nothing on D.  The 
budgeted daily costs for A, B, C and D are $500, $300, $400 and $700, respectively.  The total budget 
for A is 10*$500 or $5,000.  To determine BCWS, assume five working days have transpired.  Assume 
five-day work weeks, with no work being done on Saturday or Sunday.  For example, the BCWS for B 
is 5*$300 = $1,500.  Determine for A, B, C and D, BCWP, BCWS, ACWP, CV (= BCWP – ACWP), SV 
(= BCWP – BCWS), SPI and CPI.  Complete the following table. 
 

TASK TOTAL 
BUDGET 

%COMP ACWP 
(AC) 

BCWS 
(PV) 

BCWP 
(EV) 

CV SV CPI SPI 

A          

B          

C          

D          

Totals          

 
What is the BAC, Budgeted Cost at Completion?  What is the EAC, Estimated Budget at Completion?  
What is the Estimated Time to Complete the project, ETAC, assuming an existing completion TIME of 
15 days?  Is the project ahead of or behind schedule?  Is the project over or under its budget?  Will the 
entire project be early or delayed? 
 
9.  For the network below, calculate for each task, BCWP, BCWS, ACWP, CV, SV, CPI, SPI.  Calculate 
these numbers for the entire project as well. 
 

 
 
For each of the six tasks that make up the project above, assume the following: 
 

A/10

B/6

C/9

D/5

A/10

B/6

C/9

D/5

A/8

B/9

C/7

D/6

E/9

F/5

A/8

B/9

C/7

D/6

E/9

F/5

A/8

B/9

C/7

D/6

E/9

F/5



 

CHAPTER 12—PROJECT EXECUTION AND CONTROL…, COPYRIGHT 2016   JAMES R. BURNS.  ALL RIGHTS RESERVED P.35 

. . . . . . . . . 
 

TASK Percent Complete Expenditures/Day Actual Expenditures to Date 

A 100% $1,000 $10,000 

B 100% $1,200 $9,000 

C 30% $1,000 $4,000 

D 20% $1,500 $5,000 

E 40% $1,500 $3,000 

F 0% $1,000 $0 

 
From the above, it should be clear the total budget for A is 8*1,000 or $8,000.  Assume that the project 
is 12 days old (12 business days have transpired), where the units on time are days.  Clearly, the 
BCWS for A is 8*$1,000 = $8,000; the BCWP is also $8,000 because it is 100% complete.  Use the 
following table to complete your analysis. 
 

TASK TOTAL 
BUDGET 

%COMP ACWP 
(AC) 

BCWS 
(PV) 

BCWP 
(EV) 

CV SV CPI SPI 

A $8,000 100% $10,00
0 

      

B  100% $9,000       

C  30% $4,000       

D  20% $5,000       

E  40% $3,000       

F  0% $0       

Totals          

 
For the entire project calculate BAC, EAC, TAC, ETAC.  Comment on whether the entire project is 
behind schedule or not.  Solve this problem using a spreadsheet. 
 
10.  Solve the problem immediately above with the use of MS Project.  Contrast the numbers it creates 
with those you produced in problem 9 above. 
 
11.  For the network below, calculate for each task, BCWP, BCWS, ACWP, CV, SV, CPI, SPI.  
Calculate these numbers for the entire project as well. 
 

 
 
For each of the seven tasks that make up the project above, assume the following: 
 
 
 
 
 
 

A/8

F/9

B/9

C/7

D/6

E/5

G/4A/8

F/9

B/9

C/7

D/6

E/5

G/4
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TASK Percent Complete Expenditures/Day Actual Expenditures to Date 

A 100% $1,000 $10,000 

B 100% $1,200 $9,000 

C 30% $1,000 $4,000 

D 20% $1,500 $5,000 

E 40% $1,500 $3,000 

F 0% $1,000 $0 

G 0% $1,200 $0 

 
From the above, it should be clear the budget for A is 8*1,000 or $8,000.  Assume that the project is 12 
working days old (12 business days have transpired).  Clearly, the BCWS for A is 8*$1,000 or $8,000; 
the BCWP is also $8,000 because it is 100% complete.  Use the following table to complete your 
analysis. 
 

TASK TOTAL 
BUDGET 

%COMP ACWP 
(AC) 

BCWS 
(PV) 

BCWP 
(EV) 

CV SV CPI SPI 

A $8,000 100% $10,00
0 

      

B  100% $9,000       

C  30% $4,000       

D  20% $5,000       

E  40% $3,000       

F  0% $0       

G  0% $0       

Totals          

 
For the entire project calculate BAC, EAC, TAC, ETAC.  Comment on whether the entire project is 
behind schedule or not.  Solve this problem using a spreadsheet. 
 
12.  Use MS Project to perform all calculations in problem 11 above.  Contrast the numbers it creates 
with those you produced in 11 above. 
 
13.  For the network below, calculate for each task, BCWP, BCWS, ACWP, CV, SV, CPI, SPI.  
Calculate these numbers for the entire project as well. 
 

 
 
For each of the six tasks that make up the project above, assume the following: 
 
 
 
 

A/8

F/9

B/8

C/9

D/4

E/9

G/4A/8

F/9

B/8

C/9

D/4

E/9

G/4
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TASK Percent Complete Expenditures/Day Actual Expenditures to Date 

A 100% $1,000 $10,000 

B 20% $1,200 $9,000 

C 50% $1,000 $4,000 

D 80% $1,500 $5,000 

E 0% $1,500 $3,000 

F 0% $1,000 $0 

G 0% $1,200 $0 

 
From the above, it should be clear the budget for A is 8*1,000 or $8,000.  Assume that the project is 10 
working days old (10 business days have transpired).  Clearly, the BCWS for A is 8*$1,000 or $8,000; 
the BCWP is also $8,000 because it is 100% complete.  Use the following table to complete your 
analysis. 
 

TASK TOTAL 
BUDGET 

%COMP ACWP 
(AC) 

BCWS 
(PV) 

BCWP 
(EV) 

CV SV CPI SPI 

A $8,000 100% $10,00
0 

      

B  20% $9,000       

C  50% $4,000       

D  80% $5,000       

E  0% $3,000       

F  0% $0       

G  0% $0       

Totals          

 
For the entire project calculate BAC, EAC, TAC, ETAC.  Comment on whether the entire project is 
behind schedule or not.  Solve this problem using a spreadsheet. 
 
14.  Use MS Project to perform all calculations in problem 9 above.  Contrast the numbers it creates 
with those you produced in problem 13 above. 
 
15.  A six-task problem is depicted below that is 12 days old. 
 

 
 
For each of the six tasks that make up the project above, assume the following: 
 
 
 
 
 

A/7

B/9

C/7

D/6

E/9

F/5

A/7

B/9

C/7

D/6

E/9

F/5

A/7

B/9

C/7

D/6

E/9
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TASK Percent Complete Expenditures/Day Actual Expenditures to Date 

A 100% $1,000 $9,000 

B 100% $1,200 $9,000 

C 80% $1,000 $4,000 

D 90% $1,500 $5,000 

E 20% $1,500 $3,000 

F 0% $1,000 $0 

 
From the above, it should be clear the budget for A is 7*1,000 or $7,000.  Assume that the project is 12 
days old (12 business days have transpired), where the units on time are days.  Clearly, the BCWS for 
A is 7*$1,000 or $7,000; the BCWP is also $7,000 because it is 100% complete.  Use the following 
table to complete your analysis. 
 

TASK TOTAL 
BUDGET 

%COMP ACWP 
(AC) 

BCWS 
(PV) 

BCWP 
(EV) 

CV SV CPI SPI 

A $7,000 100% $9,000       

B  100% $9,000       

C  80% $4,000       

D  90% $5,000       

E  20% $3,000       

F  0% $0       

Totals          

 
For the entire project calculate BAC, EAC, TAC, ETAC.  Comment on whether the entire project is 
behind schedule or not.  Solve this problem using a spreadsheet. 
 
16.  Set problem 15 up in MS Project.  Contrast the numbers it creates with those you produced in 
problem 15 above. 
 
17.  For the problem 15 above, assume that each of the above six task contain 33% safety.  Remove 
the safety from each task by reducing its duration by 33%.  Place the safety appropriately in feeding or 
project buffers as explained in the chapter. 
 
18. For the network below, calculate for each task, BCWP, BCWS, ACWP, CV, SV, CPI, SPI.  
Calculate these numbers for the entire project as well.  Assume the project is 14 days old.  Assume all 
tasks will be started at their earliest start times. 
 

 
 
For each of the six tasks that make up the project above, assume the following: 
 
 

A/11

B/10

C/7

D/10

E/9

F/5

A/11

B/10
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TASK Percent Complete Expenditures/Day Actual Expenditures to Date 

A 100% $1,000 $10,000 

B 100% $1,200 $9,000 

C 80% $1,000 $4,000 

D 90% $1,500 $5,000 

E 20% $1,500 $3,000 

F 0% $1,000 $0 

 
From the table above, it should be clear the budget for A is 11*1000 or $11,000.  The project is 14 days 
old (14 business days have transpired), where the units on time are days.  Clearly, the BCWS for A is 
11*$1,000 or $11,000; the BCWP is also $11,000 because it is 100% complete.  The BCWS (= PV) for 
C, however, is 3*$1,000 = $7,000, while the BCWS for F is 0. 
 

TASK TOTAL 
BUDGET 

%COMP ACWP 
(AC) 

BCWS 
(PV) 

BCWP 
(EV) 

CV SV CPI SPI 

A $11,000 100% $10,00
0 

      

B  100% $9,000       

C  80% $4,000       

D  90% $5,000       

E  20% $3,000       

F  0% $0       

Totals          

 
For the entire project calculate BAC, EAC, TAC, ETAC.  Comment on whether the entire project is 
behind schedule or not. 
 
19.  For the network below, calculate for each task, BCWP, BCWS, ACWP, CV, SV, CPI, SPI.  
Calculate these numbers for the entire project as well. 
 

 
 
For each of the seven tasks that make up the project above, assume the following: 
 

TASK Percent Complete Expenditures/Day Actual Expenditures to Date 

A 100% $1,000 $10,000 

B 100% $1,200 $9,000 

C 30% $1,000 $4,000 

D 20% $1,500 $5,000 

E 40% $1,500 $3,000 

F 0% $1,000 $0 

G 0% $1,200 $0 

A/8

F/9

B/9

C/7

D/6

E/5

G/4A/8

F/9

B/9

C/7

D/6

E/5

G/4
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From the above, it should be clear the budget for A is 8*1,000 or $8,000.  Assume that the project is 14 
working days old (14 business days have transpired).  Clearly, the BCWS for A is 8*$1,000 or $8,000; 
the BCWP is also $8,000 because it is 100% complete.  Use the following table to complete your 
analysis. 
 

TASK TOTAL 
BUDGET 

%COMP ACWP 
(AC) 

BCWS 
(PV) 

BCWP 
(EV) 

CV SV CPI SPI 

A $8,000 100% $10,00
0 

      

B  100% $9,000       

C  30% $4,000       

D  20% $5,000       

E  40% $3,000       

F  0% $0       

G  0% $0       

Totals          

 
For the entire project calculate BAC, EAC, TAC, ETAC.  Comment on whether the entire project is 
behind schedule or not.  Solve this problem using a spreadsheet. 
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CORPORATE CASE—Stonebridge Technology 

This $70-$100 million dollar company is growing very rapidly and competes regularly with big-six 
consulting firms.  They are the #1 Sun reseller in the Dallas-Forth Worth (DFW) Area.  They are “best-
in-class” in HP in the DFW metroplex.  They are considered a Premier ORACLE systems integrator.  
They do projects involving the use of Netscape products, OLAP—business objects, and micro-strategy.  
They provide project consulting in which they help companies organize their project teams, plans, 
methodology, etc.  They do lots of data warehousing.  They take a RAD focus and are looking for long-
term relationships with firms.  In terms of back-end products they are experienced with and have 
expertise in the use of Oracle/Sybase/Informix.  In terms of front-end, they use Power-Builder, Visual 
Basic on a WIN98 or NT client.  Servers can be Unix or NT.  They are very bullish on relational OLAP, 
very datamart driven.  They are building WEB-enabled applications, C/S financial applications, Intranet 
systems utilizing JAVA scripts. 
 

One of Texas Tech alumni, Keith Robertson (Class of 1996), interacts regularly with CEO’s 
and Presidents at his level.  He gets involved with projects from start to finish.  He is currently handling 
a project with a large insurance company.  He wants FedEx reliability—able to produce the product by 
its due date every time.  He wants his clients to be raving fans.  The company wants each project to be 
rewarding to the individual, yet challenged to the ultimate.  It is like drinking from a fire hose.  The firm is 
profitable, debt free.  Clients include AMD, Compaq, CompUSA, and Texas Instruments.  Goal is to 
take the company public.  They are finding there is lots of room for growth as a regional systems 
integrator.  Their competitors are Accenture, PricewaterhouseCoopers, EDS, and Systems House.  
They provide a minimum of two-week training each year.  They use the waterfall and spiral 
development methodologies.  There is a requirements definition phase.  The time entailed to execute 
the requirements definition, detailed design, development, test and implementation phases is 
compressed.  They get the customer into the feedback loop at each phase.  They will insist on breaking 
the total project down into usable, deliverable chunks.  There is a customer sign-off on the deliverable 
at the end of each phase and the customer pays at the end of each phase.  Stonebridge’s mission is to 
provide open systems solutions—to add value.  (You have to add a dollar of revenue or you have to 
subtract a dollar of cost.)  Fairness and fun is important to the company’s culture; they want everyone 
to grow. 
 

They have created Stonebridge University.  It is designed to be modular.  Some courses take 
as little time as a week; others take as long as seven weeks.  Initial modules are designed to support 
later modules.  After the “boot-camp” in information technology is completed, the student selects one or 
more “tracks” for specialization.  Follow-up tracks include decision support, intranet development, and 
system integration.  It is hard work, but made to be fun; there is stress involved just as there would be in 
any real-world project.  They spend a lot of time on establishing a corporate vision with their own 
student-employees.  They video-tape and role-play.  They believe strongly in soft-skills—
communication, coordination, collaboration.  They teach their students how to understand clients who 
put a spin on a collection of requirements and get aggravated.  When they are told you are going to get 
requirements for a system from them, you must understand their personality and how to manage that.  
A lot of role playing takes place in front of a video camera.  Leadership and team-building are 
important.  They use outside consultants to teach personal productivity skills, time management skills 
and professional excellence skills. 
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Supplement 12.1:  TRACKING AND CONTROLLING YOUR 
PROJECT WITH MS PROJECT 200X 
 
Tools within MS Project 200x let you know how the project is progressing, whether its going as it was 
planned. To track the progress, you need to save key progress-indicating information after fine-tuning 
your project and before the project starts.  This information is called the baseline.  It is against this 
information that you compare the actual data.  Tracking helps you to: 
 

 Identify sources of problems, such as project finish date being pushed out & cost overruns. 

 Determine solutions to the problems. 

 Develop project history which can be used to improve future project planning. 
 
Baseline 
 
A baseline is the approved project plan and budget information such as task start and finish date, 
resource assignments & costs that represent the best estimate of how your project will progress and 
how much it will cost.  To set a baseline: 
 
1. On the Tools menu, point to Tracking and then click Save Baseline. 
2. Select Save Baseline and Entire project. 
 
Putting in the actual information 
 
Generally, the information that is tracked and updated are: 
 

 Task start dates. 

 Task finish dates. 

 Task remaining duration 

 Task cost 

 Work 

 Percentage of task that is complete. 
 
Entering actual start and finish dates or actual duration for a task 
 
1. On the View menu, click Gantt Chart. 
2. In the Task Name field, select the task to update. 
3. On the Tools menu, point to Tracking and click Update Tasks. 
4. To enter actual start and finish dates:  Under Actual, type the dates in the start and finish boxes. 
Note:  The dates you type will appear in the Actual Start and Actual finish fields of the selected task. 
5. To enter the actual duration of a task:  In the Actual Duration box, enter the actual duration of the 
task. 
 
Indicating progress on a task as a percentage 
 
MS Project displays percent complete as a thin black line within Gantt bars to indicate progress on a 
task as a percentage: 
 
1. On the View menu, click Gantt Chart. 
2. In the Task Name field, select the task you want to update; double-click on it. 
3. On the Task Information box, click the General tab. 
4. In the Percent complete box, type a whole number between 0 and 100. 
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Updating work completed on a task 
If the availability of the resource is crucial to your project and you want to track the work that each 
resource is performing, you can track task progress by updating the work completed on each task by 
each.  To update the work completed on a task: 
 
1. On the View menu, click Task Usage. 
2. On the View menu, point to Table, and then click Tracking. 
3. Drag the divider bar to the right to view the Activity work field. 
4. In the Activity Work field, type the updated work value and the duration abbreviation for the 
assigned resource under the task for which you want to update the actual work value. 
 
Updating actual costs for a resource assignment manually 
 
By default MS Project calculates the actual cost of a resource assignment as the task progresses, 
according to the accrual method you choose.  To enter the actual cost of a resource assignment the 
automatic calculation has to be turned off and the cost has to be entered as follows: 
 
1. On the Tools menu, click Options, and then click the Calculation tab. 
2. Clear the Actual costs are always calculated by Microsoft Office Project check box. 
3. Click OK. 
4. On the View menu, click Task Usage. 
5. On the View menu, point to the Table , and click Tracking. 
6. Drag the divider bar to the right to view the Activity Cost field. 
7. In the Activity Cost field, type the actual cost for the assignment for which you want to update 
costs. 
 
ANALYZING THE VARIANCE BETWEEN ACTUAL DATA AND THE BASELINE DATA. 
 
A variance is any difference between baseline data and actual data.  Among the most important 
variances that have to be looked into when comparing the updated schedule to the baseline data are 
the following: 
 

 Tasks that are starting or finishing late. 

 Tasks that require more or less work than scheduled. 

 Tasks that are progressing more slowly than planned. 

 Tasks that are costing more than you planned for the actual work that’s been completed. 

 Resources that aren’t working hours as scheduled. 
 
Displaying progress lines to determine project status 
 
A progress line is a vertical line that represents either the current date or status date that you specify. It 
gives you an idea as to whether the project is ahead of or behind schedule.  Jutting from a progress line 
are horizontal peaks connected to taskbars representing tasks that are either in progress or should 
have started prior to the current date or status date.  A peak pointing leftwards indicates a task that is 
either behind schedule or hasn’t been completed.  A progress line pointing rightwards indicates a task 
that is ahead of schedule.  A progress line does not connect to completed tasks or tasks that start after 
the progress-line date. 
 
To display progress lines: 
 
1. On the View menu click Gantt Chart. 
2. On the Tools menu, point to Tracking, and click Progress Lines. 
3. Click the Dates and Intervals tab, select the Always display current progress line check box.  
To show the progress for the project status date, select At project status date.  To show progress for 
the current date, select At current date. 
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4. To show your progress relative to baseline data, on the Dates and Interval tab, under Display 
progress lines in relation to, select Baseline plan. 
 
Viewing baseline costs and actual costs on a daily basis 
 
When costs matter and need to be tracked closely, you can do this by comparing baseline costs with 
the actual costs in the task usage view, which breaks down cost on a day-by-day timescale.  To view 
baseline costs and actual costs on a daily basis, do the following: 
 
1. On the View menu, click Task Usage. 
2. On the View menu, point to Table, select Cost. 
3. On the Format menu, click Detail Styles, and then select the Usage Details tab. 
4. In the Available fields list, hold down CTRL, click Actual Cost, Baseline Cost and Cost. 
5. Click Show. 
 
Determining if tasks are starting and finishing on time 
 
1. On the View menu, click Tracking Gantt. 
2. On the View menu, point to Table and then click Variance.  MS Project displays the scheduled 
and baseline dates for each task. 
3. Drag the divider bar to the right to view the Variance fields. 
 
Determining if tasks are using more or less work than planned. 
 
1. On the View menu, click Gantt Chart. 
2. On the View menu, point to the Table, and then click Work. 
3. Drag the divider bar to the right to view the Work and Baseline fields. 
4. Compare the values in the Work and Baseline fields. 
 
Determining if tasks cost more or less than budgeted 
 
1. On the View menu, click Gantt Chart. 
2. On the View menu, point to the Table, and then click Cost. 
3. Drag the divider bar to the right to view the Total Cost and Baseline fields. 
4. Compare the values in the Total Cost and Baseline fields. 
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WHAT IS THIS ABOUT?  PERHAPS IT CAN BE PUT IN COMMUNICATION MANAGEMENT? OR 
CLOSE OUT? 
 
 
The next step to successfully completing a project on schedule is to make visible progress towards the 
goal.  The project manager communicates the progress toward the goal of completion to the rest of the 
stakeholders. 
 
One step towards successfully completing a project on time is to create a project stage deliverable 
completion checklist.  This is concerned with completing deliverables, project stages, or the entire 
project and turning it over to the client.  It provides guidelines for ensuring that product acceptance and 
project or stage completion steps are visible and acknowledged by all individuals involved.  The project 
manager may delegate some responsibilities to the stage coordinator or other members of the team. 
 
Another step in successfully completing a project on schedule is project or stage completion.  The 
process to be followed to ensure that all parties accept that the end has occurred is for a project stage 
completion form to be completed.  The purpose of this form is to answer the question, “Is the project or 
stage completed?”  It provides a formal mechanism to communicate to all participants the completion of 
each project, sub-project or stage, and the acceptance of responsibility for the results by the acceptor.  
It is the responsibility of the project manager to acquire the acceptor’s signature on this document as 
well as the signatures of those who will recommend acceptance.  The approach for the project 
manager to acquire the acceptor’s signature on this document is to work closely together.  This should 
be from the time that the unsigned document is first displayed in the project plan through to the project 
completion, which is signified by acceptance of responsibility for the project’s results, by the acceptor. 
 
The next step to successfully completing a project on schedule is deliverable completion.  This step 
also requires that a form called the deliverable acceptance form be completed and signed.  This form 
ensures that deliverables are completed and the question, “Is the deliverable complete?” is answered.  
This provides a formal mechanism to communicate the completion of a project product and the transfer 
of the responsibility for the product from the project manager to the deliverable acceptor.  Like the 
project or stage completion step, this step also requires that the project manager and the acceptor work 
closely from deliverable initiation to deliverable completion. 
 
The second to last step to be followed in successfully completing a project on schedule is to complete a 
stage completion report.  This report will build acceptor and management confidence in getting project 
or stage acceptance.  The stage completion report answers the question, “How can the results of the 
project or stage be made known to all interested parties?”  In approaching the writing of this report it is 
important to remember that the contents should be a surprise to absolutely no one since the contents 
should be continually be made visible throughout the stage. 
 
The final step to be taken to ensure that projects are completed on schedule is to conduct a 
performance review.  This review serves as a notice of the culmination of a review process started 
when a team member was first assigned to a project.  The purpose of this review is to answer the 
question, “How can I let the resource managers know of the level of performance of my team 
members?”  Some suggested points to be covered by this review are as follows:  one, a description of 
the employees responsibilities, and/or goals; two, a description of the degree of attainment of each 
responsibilities; three, an assessment of overall performance; four, an assessment of skills, abilities, 
and personal suitability; five, assessment of individuals career potential and required training; and six, 
although review is to be conducted according to the resource manager, the team member should 
participate by reviewing it and commenting on it before it goes to the resource manager. 
 
When creating a project schedule, one of the most difficult decisions a project manager faces is which 
method of calculating time estimates to use.  The key to accurately creating a schedule is to 
understand the basic scheduling computations. 
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There are five of these basic computations that will be briefly discussed. The fist computation is forward 
pass computations1.  Here a forward pass is made through the network to calculate the earliest 
achievement times for each event in the network.  There are two terms to keep in mind when making 
forward pass computations: one, earliest finish or the earliest an event or activity can be completed; 
and two, earliest start or when the beginning of an event or activity is to be scheduled.  Furthermore, an 
event or activity cannot begin until all work prior to that event is completed. 
 
The second computation is the backward pass computation1.  This computation makes a backwards 
pass through the network to determine the latest time for each event in the network.  The latest time will 
represent the latest finish for a preceding activity and a latest start for a succeeding one.  Subtracting 
activity durations from a previous event late times makes this computation. 
 
The third basic scheduling computation is event slack1.  This “slack” is created when there is a 
difference between earliest finish of one event and the earliest start of the next event.  This slack can 
be used by project managers to help manage their resources more efficiently. 
 
Another basic scheduling computation is activity maximum float1.  Float occurs when an activity can 
begin and end over a longer period of time than is needed to actually complete the activity.  For 
example, activity A can begin as early as day eight and end as late as day twenty-two.  The distance 
between these two times is fourteen days.  However, the activity only takes seven days to complete.  
Therefore, the difference between the fourteen-day distance between the two events and the seven-
day working time leaves seven days for activity A to “float” around. 
 
The fifth basic scheduling computation is the critical path1.  A critical path is created when there is no 
float between activities.  Since the path has no float, if any work on the path falls behind schedule, then 
the end date will slip accordingly. 
 
Though the methods described earlier are not the only means managers may use to control schedules, 
they are likely the most effective means to do so.  Creating a schedule is one of the most difficult tasks 
a project manager faces.  However, identifying the types of activities the schedule is composed of will 
aid in the creation of a schedule.  Second, successfully completing a project on schedule is made 
possible by following the seven steps listed.  Finally, understanding the basic scheduling computations 
will prove to be a very important skill for the project manager to develop. 
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Best Practices 
 

Change Board 
 
 

Daily Build and Smoke Test 
 
This best practice is performed during the construction phase of any development project.  Developers 
will make enhancements to the product throughout the day and then at then end of each day, run the 
product through a collection of basic tests.  It will be ascertained that the product still performs certain 
basis tests correctly.  The practice reduces the likelihood of several common, time-consuming risks—
unsuccessful integration, low quality, and poor progress visibility.  The practice provides critical control 
for development projects in recovery mode.  Its success depends on developers taking the process 
seriously and on well-designed smoke tests.  This practice trades small increases in project overhead 
for large reduction in integration risk and improvement in progress visibility. 
 
The build involves 1) a recompilation of all source modules that have undergone change since the last 
build, and 2) a linking of all of the modules to create the integrated executable module, or simply the 
build.  A successful build means that all the modules are still compatible and that they still all compile 
correctly. 
 
The smoke test involves an exercise of the entire system from end to end.  It is not necessarily an 
exhaustive test that exercises every logic path in the system.  It should, however, be capable of 
detecting major problems.  If the build passes the smoke test, it is stable enough to be tested and is a 
good build.  Individual developers should not add their code to the build until they have a significant 
chunk of well-developed and tested code to add. 
 
The daily build and smoke test can be used on just about any type of development project in which 
construction is involved.  One of the largest projects it has been used on was Microsoft’s NT 
development in the mid 90’s.  This product contained 5.6 million lines of code spread across 40,000 
modules.  The daily build took 19 hours in spite of the fact that it was spread across several machines.  
Nevertheless, the development team still managed to build and test every day and the NT team 
attributed much of their success on that huge project to their daily builds.  It has been said (McCarthy, 
1995c) that if Microsoft could evangelize only one idea from its development process, the daily build-
and-smoke test practice would be the one.  Some developers claim that daily build-and-smoke test 
practices improve overall product quality; more widely accepted is the notion that daily builds will 
reduce integration risk, quality risk while increasing progress visibility. 
 

Designing for Change 
 
As its name would suggest, this best practice entails designing the product so that it is easy to change.  
This would usually mean that the product is modular so that changes made to a single module do not 
affect other modules, or at least minimally affect them.  Since the testing required subsequent to the 
change can be substantial, the basic idea is to minimize testing.  If the product is primarily a software 
product, one would want to create a “plug-and-play” landscape in which a module can be replaced and 
there are no consequences for the other modules.  To create such a landscape, the use of inheritance 
within objects must be minimized.  Inheritance creates a plethora of interconnections, all of which must 
be tested, when a parent or super-parent object gets replaced. 
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Evolutionary Delivery 
 
This is delivery in which a crude form of the product is delivered and brought online.  Then as the users 
learn more about what they want, the product is changed to reflect their maturing requirements.  The 
benefits of this best practice is that it generates at least some value for its users even as the product is 
being conceived.  This approach works well when the requirements are unstable. 
 

Evolutionary Prototyping 
 
This best practice entails prototyping the product, learning from that prototype and then evolving the 
prototype into more mature and improved forms. 


